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This manual describes the user interface of the Builder software platform, along 

with the tools you will use, if you want to generate data for ADAPT-PT and 

ADAPT-RC. Becoming familiar with the program interface and its various tools 

will serve you well in your modeling and design work.  If you have experience 

with the program and want to refresh your memory before starting a new project, 

go to Chapter 2 – Quick Reference Guide. 

This manual is divided into several chapters as follows: 

• Chapter 2 is a quick reference guide for those who have used the 

program, and simply intend to refresh your experience, before starting a 

new project 

• Chapter 3 describes the basic operations and main menus of the program 

• Chapter 4 walks you through the basic operations tools of the program. 

You will use these tools in all modeling, analysis, and design work. You 

will find the tools offer an extensive drafting capability, allowing you to 

faithfully replicate complex structures 

• Chapter 5 shows you how to build a structural model in three dimensions. 

It also covers the common situation in which you would use an architect’s 

drawing as the basis of your structural model 

• Chapter 6 targets only those of you who will be generating your structural 

models in Builder platform to create design strips for export to ADAPT-

PT  

• Chapter 7 covers the basic Finite Elements Modeling (FEM) Tools. This 

chapter introduces FEM and illustrates basic operations of meshing and 

FEM analysis 

For your next step, depending on the way you want to use the program, it is best 

to go through one or more of the program tutorials1. 

 

 
1 The tutorials can be downloaded from the download email or from the ADAPT website, 

www.adaptsoft.com/manuals. 

 

http://www.adaptsoft.com/manuals
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The natural sequence from creating a structural model, to generating structural 

documents and subsequently fabrication drawings, is listed in the following. 

There are many short cuts and alternatives in the process of data generation and 

execution. These, however, are avoided in the following list in favor of a more 

common and straightforward approach. 

2.1 GENERATE STRUCTURAL MODEL 

Generate a structural model, either by importing a DWG file and converting it to 

structural components, or creating your own structural model using the tools of 

ADAPT-Modeler. Once you are done, additional details for the analysis depend 

on whether you plan to analyze the model using ADAPT-PT, ADAPT-RC, or 

ADAPT-Floor Pro. The following is a guide. 

2.2 ANALYSIS USING ADAPT-PT OR ADAPT-RC 

If you want to use the structural model in connection with ADAPT-PT or RC1 

• Enter loads (dead and live load cases only)2. Skipping of live load, live-

load reduction and other load-related issues are handled in the PTRC 

Export ribbon, Design Criteria and Load Factor panels, which will be 

covered later, or directly in ADAPT-PT or RC. 

• Go to PTRC Export→Material Properties, and review/edit the contents 

of the following icons: 

o Concrete (Strip Method) 

o Mild Steel (Strip Method) 

o Prestressing (Strip Method) 

• Go to PTRC Export→Design Criteria and PTRC Export→Load Factor. 

Review/edit all the input screens, as these will be used as default values 

for your entire project. You will have the option to modify these 

individually once data is exported to ADAPT-PT or RC. 

 
1 The input screens that are specific to ADAPT-PT and ADAPT-RC are marked with a brown background. 

The input screens that apply to both ADAPT-PT and RC and Floor Pro are identified with a neutral 

background color. 
2  PT version 7.xx and RC version 4.xx can accept only dead and live loads, plus the optional inclusion of 

selfweight. Later versions of these programs can handle more load cases. 

You need not go to the load case and load combinations, since these are handled in ADAPT-PT and RC. 
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• Generate support lines in two orthogonal directions. If a support line is 

intended to rest on anything but a column or wall, enter a point support3. 

• Create design strips  

o Consider the design strips one by one4 

▪ Select a design strip and view its idealization in 3D 

viewer 

▪ Export/open ADAPT-PT or RC 

▪ Once in ADAPT-PT or RC, view the imported data for 

accuracy 

▪ Edit data if necessary 

▪ Execute data 

▪ Obtain a report 

o Go back to the Modeler environment and consider the next design 

strip 

2.3 ANALYSIS USING ADAPT-FLOOR PRO 

If you want to use the structural model in connection with ADAPT Floor-Pro 

• First run for model validation: 

o Go to Analysis→Meshing and click on the Mesh Generation icon. 

Accept defaults of the program. 

o Once meshing is complete, go to Analysis→ Analysis and click on 

the Execute Analysis icon. 

o Once analysis is complete, the Results Browser will open.  

o In the Loads tab of the Results Browser the user can choose the 

load combination, envelope of load combination, or load case of 

the result the user would like to review. Select the Service (Total 

Load) load combination.  

o Go to the Analysis tab of the Results Browser, here the user can 

view result contours and diagrams for components (slabs, beams, 

columns, walls). Expand the Slab tree by clicking on the + sign 

next to slabs. Expand the Deformation tree by clicking on the + 

 
3 If a support line rests on another support line, or is resting on a beam along its length, you must enter a 

point support at the location where the design strip you are creating is intended to be supported.  
4 You have the option to use the Strips pull-down menu to generate the input data for the entire set of 

design strips at one time. But if you are not familiar with the program, it is best to do them one by one, as 

suggested herein. 
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sign next to deformation. Check the box for Z-Translation. This 

will display the deflection contour for the Service (Total Load) 

load combination. Without dead and live loads, or post-tensioning 

added to the model the result should be based on the structure self-

weight alone. 

o Zoom, rotate, and view the results thoroughly to ensure that the 

deflected shape under selfweight looks reasonable. Make sure 

there is no deflection where the structure was intended to have 

been supported. Correct the structural model if the deflected shape 

and values under selfweight do not appear reasonable. 

o Alternatively, the user can use the legacy ADViewer to view 

results. Once analysis is complete, select View Analysis Results 

from the Analysis→ Analysis panel. This opens the 3D viewer of 

the program to display the solution. 

o Once in 3D viewer, select the Service (Total Load) combination 

and Z-Translation. This is vertical displacement of the structure. 

Then, click on the tool with two light-bulb graphics. This will 

display the deflected shape for the Service (Total Load) load 

combination. Without dead and live loads, or post-tensioning 

added to the model the result should be based on the structure self-

weight alone. 

o Zoom, rotate, and view the results thoroughly to ensure that the 

deflected shape under selfweight looks reasonable. Make sure 

there is no deflection where the structure was intended to have 

been supported. Correct the structural model if the deflected shape 

and values under selfweight do not appear reasonable. 

• Add loads: 

o Go to Loading→Load Case/Combo and click on the Load Cases 

icon to add load cases, such as dead load, live load, prestressing, 

and other load cases that you want to include in your design. 

o In the Loading ribbon use the other tools to enter the loading. 

• Add prestressing: If the structure has prestressing, add the prestressing 

tendons. 

• Edit material properties: Go to Criteria→Materials Properties, and 

enter the material properties for concrete, nonprestressed steel and 

prestressed steel, if applicable. If there is more than one concrete material, 

steel or prestressing in your structure, this is the time to give a label to 

each of the new materials used and define their properties. In your 

modeling, the program has assumed that all the components of the 

structure you created have the material names entered on the first line of 

each of the lists. If you added any new material to the list of existing 

materials, open the property box of the structural components that must 



Chapter 2 QUICK REFERENCE GUIDE  

10 

have the new material and change their material name to the one you 

created. It is recommended not to rename or remove the default material in 

any material list. If you want to add a specific material with a specific 

name, add a new material and modify the label of the new material leaving 

the default material intact.  

• Review/edit design criteria: Go to Criteria→Design Criteria, click the 

Design Code icon and review the default values of each of the tabs in the 

criteria window that displays. The other icons in this icon panel open the 

same criteria dialog window but to the icon specified tab. Modify the 

criteria, as necessary.  Make sure that you select the building code of your 

choice. Once you select/confirm the building code, the program 

automatically creates the default load combinations of the building code 

you selected. Note: Changing the code will reset the load combinations 

(delete any user input load combinations and revert to the default 

combinations for the selected code) in the model. Before adding to the 

load combinations, the user should ensure they are in the design code they 

want to use for the design of the model.  

• Add extra load combinations for validation: 

o Go to Loading→Load Case/Combo and click on the Load 

Combinations icon. 

o Create a load case for selfweight only5, with No Code Check 

option. 

o View and edit the load cases and load combinations. If you have 

prestressing, create a load case (PT) for prestressing only. 

o Go to Analysis→ Analysis and click on the Execute Analysis icon. 

o Once the analysis is complete use the Results Browser or, click the 

View Analysis Results icon within the Analysis→ Analysis panel to 

check the deflection shape of each load case and load combination, 

to make sure they look reasonable. If deflections do not appear 

correctly, go back to the loads, criteria, and prestressing layout, if 

needed, in order to fix the problem. 

• Design: 

o Using the support line Dynamic Editor from the Floor 

Design→Strip Modeling panel, create support lines in two 

orthogonal directions. Make sure that you assign the support lines 

in one direction X-direction, and its orthogonal direction Y-

direction. (This does not necessarily mean the support lines run in 

the X and Y direction) 

 
5 Once you add new loads, the selfweight load case is likely to become part of other load combinations. 

That is why you need to create a selfweight load combination. Also, if you plan to have skipping of live 

load, leave this option to the last, after you have made sure that the model you have created works well. 
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o Go to Floor Design→Section Design and click on Generate 

Section New. Save data. 

o From the Floor Design→Section Design and click on Design the 

Sections.  

• Check punching shear values: 

o If you have a column-supported slab, go to Floor 

Design→Punching Shear and click on Execute Shear Check. 

o Once the shear check is complete, go to the Results Browser. 

Navigate to Load Combos→Envelope→Envelope Strength. In the 

Analysis tab of the results browser the user should see a Punching 

Shear tree. Expand the Punching Shear tree and check the box next 

to Stress Check. This will turn any supports that fail the punching 

shear requirements red, supports that need reinforcing will be pink, 

and supports that pass the shear check with no need for additional 

shear reinforcement will be green. Note: For shear results to be 

active and displayed the user must have selected the strength 

envelope combination or a single strength combination.  

o To view the stress ratios, expand the Punching Shear tree in the 

Results Browser and click the check box next to Stress Ratio.   

• Generate/view reinforcement: 

o From the Floor Design→Rebar panel, click on Calculated Rebar 

Plan icon to compile a rebar drawing.  

o Go to Rebar→Visibility and click on the Show Rebar icon to make 

the reinforcement visible. This is the tool with yellow circle. 

o Use the capabilities of the other tools on this panel to view and edit 

the display. 

• Generate rebar drawings: 

o Using the tools of the Rebar→Visibility Panel, select the 

reinforcement that you want to be shown on the structural drawing. 

o Edit/move the reinforcement annotation to make it arrive at a clear 

presentation. 

o Change the font size to values suitable for printing on the paper 

size you are going to select. 

o From the File menu, select Print to examine the features of the 

drawing you are going to print. 

o Print the drawing from the print preview window, or export it to 

AutoCad, using the File→Export DWG tool of the program. 

o In the same way, generate other rebar drawings such as top bars on 

one drawing and bottom bars on another. 
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• Generate tendon layout drawings: On engineering drawings, most 

engineers group tendons into tendons in one-direction (such as banded 

tendons) and tendons in other direction (distributed tendons).6 If you plan 

to show the tendons in two drawings, you must first group them, following 

the instructions below. If this is not the case, go to the next step.  

• Group tendons: 

o From the Visibility→Display Settings panel, select the Group 

Library icon. This opens the group library. Add two group names, 

such as “banded tendons,” and “distributed tendons.” 

o Using Select/Set View Items, turn off everything except tendons 

and the other basic information you need to identify the tendons. In 

most cases, it is adequate to retain the tendons, slab outline and 

column supports. 

o Select as many tendons of one group as practical. 

o From the Modify→Properties panel, select Modify Selection. 

o Once the Modify Item Properties dialog windows open, select 

check box next to Group on the left side of the window. Select the 

group dropdown menu and choose the group label from the 

dropdown menu you want to assign the tendons to.  

o Repeat the above steps, until all tendons are assigned to their 

respective groups. 

o Go to the Grouping Dialog Window and make only one group of 

tendons visible, such as distributed tendons. Once you have printed 

the drawing for this group, hide this group and make the next 

group visible. 

• Generate single report: 

o From the Reports→Single Default Reports panel select 

Tendon→Tendon Plan. 

o In the dialog window that opens, select the following, and then 

click OK. 

▪ Tendon ID 

▪ Control point heights 

▪ Number of strands 

▪ Elongation (if you selected the option in data 

generation) 

▪ Stressing/dead end (if you selected the option in data 

generation) 

 
6 For generating fabrication drawings, tendons are grouped more extensively, assigning unique group 

identification to tendons of same length and profile. 
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• Generate compiled report: From the Reports→Compiled Reports panel, 

click on Open Report Compiler icon. Select the items of your choice and 

send to printer. 
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3.1 ADAPT-MODELER MAIN SCREEN 

Fig. 3.1-1 shows the full-screen display of the ADAPT-Modeler program, with 

typical features labeled for easy identification. 

 
FIGURE 3.1-1 

 

ADAPT-Modeler operates the same way as other Windows programs. All 

program tools are accessible through the Ribbon/Panel structure of the Graphical 

User Interface or though the Top-Left Quick Access Default Tools (1), Top-Right 

Level Tools (2), and the Bottom Quick Access Tools (4) toolbars. Ribbons can be 

customized by the user. In this document we will use the convention of Ribbon 

Name→Panel Name when describing where to access a program tool. 

The Message Bar (3) displays tool-specific information prompted to the user and 

any coordinate values that may be typed by the user for specific program 

procedures. 

The Status Bar (5) displays such information as the mouse cursor coordinates, 

current unit system, active level, current layer.  A short description of each 

specific tool also appears in this area when the mouse cursor is placed over the 

corresponding tool button. 
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The Results Browser (6) displays the contour and diagram results (deflections, 

moments, shears, etc.) for the component and load combination/load case the user 

has selected. The user can also modify the appearance of the results through the 

Settings tab. In addition, the user can set limits for the code checked items of the 

Design Strip results within the Display tab. 

The Properties/Colorize Grid (7) allows the user quick access to component 

properties for modification. Additionally, the user can use this window to colorize 

components based on their properties. Lastly the user can also filter selections 

using these tools as well.  

3.2 MOUSE FUNCTION AND OPERATION 

The primary function of the mouse is through its left-click. Depending on the 

mode of the program, as outlined in the next section, the left-click will result in 

selecting the entity below the cursor, inserting an entity or performing an 

operation at the location of the cursor.   

The right-click of the mouse with cursor on the display portion of the screen will 

display the window shown in Fig. 3.2-1. 

 

FIGURE 3.2-1 RIGHT-CLICK OPTIONS OF THE MOUSE 

Click on a menu item listed to perform the operation described. 

If you right-click the mouse over a structural component the program will bring 

up the right-click menu shown in Fig. 3.2-1 along with additional options specific 

to modification of that component. 

If you right-click the mouse while the cursor is outside the display screen, options 

to customize the ribbons or the bottom quick access panel will appear. From these 

options you can customize the programs display. 
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3.3 CURSOR FUNCTION AND OPERATION 

Depending on the cursor mode, the program responds differently. Before starting 

an operation, it is important to make sure that the cursor is in the appropriate 

mode. 
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Shape Mode Description 

 

 

 

 Selection/Pick 

In this mode, you can select an entity displayed on the 

screen by placing the cross over it and left-clicking 

the mouse. Once an entity is selected, its color 

changes. 

 

There are two ways to enable Selection/Pick mode: 

• Right-click the mouse, and select Exit 

• Go to Home→Selection Mode and click on 

the Window Selection/Pick Mode  icon.  

 
Hint 

In this mode, the program displays the identification 

of an entity that the point of the arrow touches. To 

change to this mode, go to Home→Selection Mode 

and click on the Hint Mode  icon.  

 

 

 

 

 
 

Creation 

In this mode, the program will create an entity, such 

as a line, column or slab.  Place the cross at the 

location where you want the entity to be created and 

left-click the mouse. Detailed instruction for creation 

of each entity will be prompted on the Message Bar at 

the top of the modeling space. 

 

To enable Creation Mode, left-click the mouse on the 

tool of the entity you intend to create. Then follow the 

instructions in the Message Bar. 

 

 
Snap 

In this mode, the magnet indicates that the cursor is in 

Snap Mode and is searching to snap onto an entity.  

The cursor will search for one or more entities. Once 

the cursor becomes close to any of the entities or 

conditions it is searching for, it will display a yellow 

sign over the location to be snapped. The shape of the 

yellow sign displayed identifies the entity for 

snapping. 

 

 

Undefined 

Creation 

In this mode, the program can be requested to create 

an entity, although the plane on which the entity is to 

be created is not displayed. You must change the 

screen view (go to Top View , if you are in a 

different view) before you can create the entity in 

mind. 
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3.4 OPERATION OF RETURN AND TAB KEYS 

A special function assigned to the Return key is to repeat the last operation 

performed – when the duplication of such operation is practical. For example, if 

you use Copy command to copy an entity, pressing the Return key, will invoke 

the Copy command again. 

In addition to its normal function, the Tab key can help you select an individual 

item in a group of similar items that overlap. When you attempt to select items 

that overlap, such as several beams intersecting at the same location, the mouse-

click on its own is not adequate to identify the beam of your choice. The program 

will select one and change its color. If the program’s selection is not the one you 

intended, click the Tab key. The program will select and display the next item. 

Continue clicking the Tab key, until the item of your choice is selected. 

3.5 OPERATION OF KEY COMBINATIONS 

Some key combinations act as shortcuts to pre-assigned operations. The key 

combinations are generally displayed on the computer screen, next to the menu 

items they represent. The most used combinations are: 

Copy Ctrl key + C 

Move Ctrl key + M 

 

The user can also assign hot keys. Hot keys are user defined keyboard shortcuts. 

The user can assign hot keys using the Customize Quick Access Toolbar tool.  

3.6 HOW TO END/CLOSE AN OPERATION 

To end or close an operation, such as closing a polygon, press the End or C key 

3.7 HOW TO ABANDON AN OPERATION 

To abandon an operation you have already started, such as drawing a polygon, 

press the Esc key. 
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4.1 INTRODUCTION 

 

The purpose of this section is to act as a reference guide to the menu items and 

icons in the software. Included with each icon/tool is a short description on the 

application of the tool in the software.  

4.2 MAIN USER INTERFACE 

 

 

4.2.1 Top-Left Quick-Access Default Tools (1) 

 

 

New  

Creates a new file from defaults or a template selection. 

Open  

Opens an existing Builder file.  

Save  

Saves the active Builder file. 
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Undo  

Undo previous action. 

Redo  

Redo previously undone action. 

Print  

Opens printer selection and settings and prints active screen. 

Customize Quick Access Toolbar  

Customizes the Quick Access Toolbar. 

4.2.2 Top-Right Level Tools (2) 

 

 

Level Assignment  

Opens the Reference Plane Manager to create, edit or remove model levels 

and associated level heights and names.  

Active Level Up  

Sets the active plane to the next level above in vertical sequence.  

Active Level Down  

Sets the active plane to the next level down in vertical sequence.  

Active Level Manager   

Displays the current active level, and allows the user to navigate to and set 

levels active through a dropdown style menu. 

Single-Level mode  

Sets the modeling and analysis mode to view a single level.  This level is 

the only active level in this mode.  Any program function used in Single-

Level mode applies only to components at the level shown.  Use the 

Active Level Up and Active Level Down mode to switch to other levels. 

Analyses run in Single-Level mode consider only the current plane.   
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Multi-Level mode  

Sets the modeling and analysis mode to view the entire modeled structure. 

Any modeling function used in Multi-Level mode applies only to set 

current plane shown in the Status Bar. Use the Active Level Up and 

Active Level Down mode to set the active plane to another level.  

Analyses run in Multi-Level mode consider the entire structure.   

Help  

Gives access to documentation, ADAPT-Builder version information, 

EULA and ADAPT website.  

Help expanded 

 
 

o Documentation  

Opens a folder containing program related documentation in 

windows explorer. 

o About RISA  

Opens a window providing general contact information for RISA, 

Tech. 

o About Builder  

Gives ADAPT-Builder version information and support contact 

information.  

o Technical Support  

Opens a window displaying contact information for ADAPT’s 

support department. 

o EULA  

Opens a window displaying the End-User License Agreement of 

the software. 
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4.2.3 Message Bar (3) 

 

 

Display’s model information or prompts user for input.  

4.2.4 Bottom Quick Access Tools (4) 

 

  

See tool descriptions on individual toolbars and use them here for non-

snap and grid tools.  Leave as-is for snap and grid settings/grid active.  

4.2.5 Bottom-Right – Status Bar (5) 

 

 

 

Cursor coordinates   

Shows X, Y and Z global coordinates of the current cursor position.  

Units  

Shows the current system of units: US, SI or MKS.  To change units for a 

model, export the model using FILE-Export-.INP and import the file from 

FILE-Import-.INP.  

Level  

Reports the active plane. Use the Active Level Up and Active Level 

Down mode to set the active plane.  

Layer  

Reports the active layer.  Select this text to change the active layer.   
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4.2.6 The Result Browser (6) 

 

Graphical Result Browser. The user can view graphically by load 

combination/load case the results/actions for Slabs, Beams, Columns, 

Walls, Design Strips, Punching Shear results, and more. In addition the 

user can edit the code check limits as well as the display of graphical 

results within the Result Browser. 
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4.2.7 Properties/Colorize Grid (7) 

 

The added property and colorize grid adds user efficiency to the program. 

The properties grid allows quick access to the properties of a selected, or 

multiple selected items. The item’s properties can be modified within the 

Properties Grid dialog window. The colorize tab allows the user to 

colorize components based on properties for an easy graphical verfication 

of component properties. Both options also allow filtering of selected 

items. For detailed information on the Properties/Colorize grid refer to the 

ADAPT-Builder 20 New Features Supplement Manual. 
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4.3 FILE RIBBON 

 

 

New  

Creates a new file from defaults or a template selection. 

Open  

Opens an existing Builder file.  

Recent  

Lists the last four Builder files saved from the machine.  

Save  

Saves the active Builder file.  

Save As…  

Save the active Builder file as a new name. 
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Save as Version 2012  

Saves the files to a previous version for backward compatibility.  Stiffness usage 

cases and customized rebar libraries are reset to program defaults.  

Save as Project Template  

Saves the criteria, material or load combinations as an ADAPT template .apt file.   

Auto Save Settings  

Opens the Automatic Save Options window to enable auto-save and backup and 

to set a save time interval.   

Import  

Opens options to import: 

o .INP file (generic ADAPT exchange file) 

Used to update or create a new file from another Builder .adm file or 

from the ADAPT-Revit/ADAPT-Etabs/ADAPT-TSD integration links.   

o .DWG/DXF file 

Used to import an existing Autocad file to create a new Builder .adm file 

through polygon transformation.  

o .XLS file 

Used to import point and line loads from a formatted Excel file  

Export 

Opens options to export: 

o .INP file (generic ADAPT exchange file)  

Used to update or create a Builder .adm 

o .DWG/DXF file 

Used to export drawing data from Builder to  Autocad  

o Revit 

Used to create a new Revit .rvt file.  

o S-Foundation 

Used to export loading and reaction data to S-Foundation.  

o Visicon 

Used to create a new Visicon model for BIM coordination.   
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Title Block Info 

Opens window the user can enter general information about the project/model. 

The information is used in the graphical and tabular reports of the software.  

Print 

Opens printer selection and settings and prints active screen.    

Exit  

Exits the application. 

4.4 HOME RIBBON 

 

 

4.4.1 Display Panel 

 

      

Customize User Interface Tools  

Includes settings to customize the Builder User Interface and graphical 

modeling environment.   

 

o General Settings 

Settings for delete confirmation, property window behavior when 

modifying component properties, cursor properties and cursor 

scroll settings.    
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o Text Settings 

Font type and size of text identifiers. 

o Dynamic Dimension Settings  

Customize the display of length, angle and reference line for 

dynamic dimensioning and sets incremental distance and angle 

(degrees).   

o Folder for Saving Data 

Sets the default or custom location for saving ADAPT-PT/RC .adb 

files when using the Strip Method option.  

Layer Settings  

Controls layer options to delete or create new layers, modify layer 

properties and layer display.   

Line Style Settings  

Controls linestyle options to delete or create new linestyles or modify 

linestyle properties.    

4.4.2 Selection Mode Panel 

 

 

Window Selection/Pick Mode  

Selects all visible items that are picked with the cursor or located within 

the drawn window.  Press CTRL+ to select multiple picked or windowed 

components.   

Lasso Selection  

Selects the items located within the draw lasso. 

Path Selection  

Selects the items located on the drawn path polyline.   
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Move Selected Point  

Enables component handles that can be selected to move components. Can 

be used to move only the first selected component.  

Move Selection   

Enables component handles than can be selected to move components.  

Can be used to move multiple, selected components.  

Hint Mode  

Displays the components label, layer and linestyle when the cursor is 

hovered over the component.  

4.4.3 Selection Tools Panel 

 

 

Select by Type  

Opens dialog window to select components by type with criteria filters.     

Select All  

Selects all the visible items.  

Select by Layers  

Opens dialog window to select components by listed layers.   

4.4.4 Draw Panel 

 

Create point  

Creates a point at the selected location.  
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Create Line  

Creates a line by start and end point. 

Create Line Expanded 

 

o Continuous Modeling  

Continues the current operation of modeling a component by 

entering sequential endpoints of each modeled component 

segment.  

Create Polyline  

Creates a polyline by specifying mutliple points with straight line 

segments between points.  

Create Polygon  

Creates a polygon by snap-point input.   

Create Polygon Expanded 

 

o Create Polygon  

Creates a polygon by snap-point input.   

o Polygon: Vertices, Center, Radius  

Creates a polygon by specifying number of vertices, center and 

radius. 

o Polygon: Vertices, Diameter  

Creates a polygon by selecting number of sides, start point at mid-

distance location of first edge, and end point at mid-distance 

location of second edge. 
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o Polygon: Vertices, Start Edge, End Edge  

Creates a polygon by selecting number of sides, start point at mid-

distance location of first edge, and end point at mid-distance 

location of second edge.   

Circle:  Center, Radius  

Creates a circle by specifying center and radius. 

Circle: Center, Radius Exapanded 

 

o Circle:  Center, Radius  

Creates a circle by specifying center and radius. 

o Circle:  Three Points  

Creates a circle by specifying three points. 

o Circle:  Diameter  

Creates circle by specifying insertion point and diameter.   

Arc: Start, End, Radius  

Creates an arc by specifying starting, ending, and radius value. 

Arc: Start, End, Radius Expanded 

 

o Arc: Start, End, Radius  

Creates an arc by specifying starting, ending, and radius value. 
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o Arc: Start, Center, End  

Creates an arc by specifying start, center and end points.   

o Arc: Three Points  

Creates an arc by specifying three points. 

o Arc: Radius, Angle  

Creates an arc by specifying radius and angle.  

o Arc: Radius, Chord  

Creates an arc by specifying radius and chord. 

Select Position, Write Text  

Creates text by specifying starting point, height and direction, then 

entering text.  

Select Position, Write Text Expanded 

 

o Select Position, Write Text  

Creates text by specifying starting point, height and direction, then 

entering text.  

o Write Text, Selection Position  

Creates text by entering text, specifying starting point, height and 

direction. 

Create Dimension  

Creates a dimension by specifying start and end point and position.  

Create Section Cut  

Creates a section cut by specifying start and end point for the cut line and 

selecting an insertion point.   
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4.4.5 Tools Panel 

 

 

Measure Tool  

Measure the distance between two points. 

Coordinates  

Reports the X, Y and Z coordinates of a user-selected point.  

Calibrate  

Calibrates the graphical model workspace by selecting two points and 

specifying the distance between the points.   

Change Project Origin  

Changes the current project origin to a user defined origin position. 

4.4.6 Zoom/Camera Panel 

 

 

Zoom Window  

Enlarges the items selected in the zoom window.  

Top View  

Displays the model from a top perspective.  

Top-Left View  

Displays the model from a top-left perspective.  

Zoom Extents  

Resets the view to extents of the modeled components.   
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Bottom View  

Displays the model from a bottom persepective.  

Top-Right View  

Displays the model from a top-right perspective. 

Dynamic Zoom  

Reduces or enlarges the model view from a user-defined selected point.  

Left View  

Displays the model from a left perspective.   

Rear View  

Displays the model from a rear perspective.   

Zoom In  

Enlarges the model view from a user-defined selected point.  

Right View  

Displays the model from a right perspecitve. 

Top-Front-Right View   

Displays the model from top-front-right perspective.  

Zoom Out  

Reduces the model view from a user-defined selected point. 

Front View  

Displays the model from a front perspective. 

Top-Back-Side View  

Displays the model from a top-back-side perspective.  

Rotate View  

Rotates the model view from a user-defined selected point and rotation by 

mouse control.  



 TOOLBARS AND DIALOG WINDOWS Chapter 4 

41 

Pan View  

Pans the model view from a user-defined selected point and mouse 

control. 

Redraw  

Redraws the current model view.  

4.4.7 Viewport Panel 

 

 

Single  

Creates a single viewport window. This is the default viewport of the 

software. 

Single Expanded 

 

o Two Vertical  

Creates the viewport shown.   

o Two Horizontal  

Creates the viewport shown. 

o Three Vertical  

Creates the viewport shown.   
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o Three Horizontal  

Creates the viewport shown. 

o Four Equal  

Creates the viewport shown.   

o Four Horizontal  

Creates the viewport shown. 

4.4.8 WCS/UCS (Coordinate Systems) Panel 

 

 

Display WCS  

Turns off/on the axes of the global coordinate system at the model origin.  

Transform UCS to WCS  

Transforms the defined User Coordinate System to the World Coordinate 

System.  

UCS at last point  

Positions the User Coordinate System and origin at a user-defined point.  

UCS at end-point of last line  

Positions the User Coodinate System and origin at the end-point of a user-

defined line.   

UCS: 5 points  

Defines User Coordinate System (UCS) by: origin, X start, X end, Y start, 

Y end. 

UCS: 3 points  

Defines User Coordinate System (UCS) by: origin, X end, Y end. 



 TOOLBARS AND DIALOG WINDOWS Chapter 4 

43 

4.4.9 Scaling Panel 

 

 

Decrease Scale Factor  

Decreases the scale factor in the selected coordinate direction/s. Object 

labels are not scaled.  Reset scale factor to position objects back to label 

location.   

Reset Scale Factor  

Resets the the scale factor to the program default for the selected 

coordinate direction/s.  

Increase Scale Factor  

Increases the scale factor in the selected coordinate direction/s.  Object 

labels are not scaled.  Reset scale factor to position objects back to label 

location.   

Modify the X-Direction Scale  

Enables scaling distortion in the X-Direction. 

Modify the Y-Direction Scale  

Enables Scaling distortion in the Y-Direction. 

Modify the Z-Direction Scale  

Enables Scaling distortion in the Z-Direction.  

4.4.10 Snap Tools Panel 

 

 

Snap to Endpoint  

Snaps to the closest endpoint.   
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Snap to Midpoint  

Snaps to item’s midpoint.   

Snap to Center  

Snaps to the center of a radial item.   

Snap to Intersection  

Snaps to closest point of intersection.   

 

Snap to Perpendicular  

Snaps to the perpendicular point on the item that is currently under the 

mouse cursor.  

Snap to Nearest  

Snaps to the nearest position of the considered item. 

Snap to Grid  

Snaps to the closest point on the grid. 

Snap to Verticies of Components  

Enables snapping to the verticies of a structural component.  

Snap Orthogonal  

Toggles Ortho mode. 

Snap Settings  

Opens the Snap Settings dialog box. 

Grid Settings  

Opens the Grid Settings dialog box 
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4.5 VISIBILITY RIBBON 

 

4.5.1 Message Bar Panel 

 

 

Message Bar  

Enables or hides the User Command Bar for X, Y, Z or dimension input.  

When the bar is disabled, all node point entry must be performed using 

mouse clicks with Dynamic Dimensioning guidance when active.   

Prop. Grid  

Enables or hides the Properties Grid. Allows the user quick access to 

selected component properties. Modifications to the properties of 

components can be made in this window. When disabled, properties for a 

component must be modified through the components property window.  

The Properties Grid window can be detached and docked to any side of 

the UI or left free floating. 

Colorize  

Enables or hides the Colorize Grid. Allows the user to colorize 

components based on component properties. The colorize window can be 

detached and docked to any side of the UI or left free floating. 



Chapter 4 TOOLBARS AND DIALOG WINDOWS  

46 

4.5.2 Colors Panel 

 

 

Color Palette  

Opens the Color Palette menu to set outline, line and fill colors and 

opacity settings for structural components, analytical elements and loads.  

Use this option to set the background color.  These settings apply to 

newly-created components.  Existing components will retain their set color 

unless modified by Component Properties or Modify Item Properties.  

4.5.3 Section Panel 

 

 

Create Section Cut  

Creates a section cut by specifying start and end point for the cut line and 

selecting an insertion point.   

4.5.4 Render Panel 

 

 

Render Model  

Opens the ADAPT Solid Modeling Viewer.  This tool is used to 

dynamically view the model components, imported CAD drawings, and 

view displacements and deformations.    
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4.5.5 Display Settings Panel 

 

 

Default Display  

Restores the view to the user-defined default display 

View Settings (Select/Set View Items)  

Defines the graphical display settings for structural components, analysis 

elements and loading.  Controls font and symbol sizes for all items.  

Group Library  

Opens the Grouping dialog window.  This is used to create, delete, enable 

display of groups by on/off, and manage imported CAD files.  If a group is 

fully displayed in the model the lightbulb icon will appear solid yellow.  If 

the group is partially displayed the icon will appear half-tone. If all 

components of a group are not displayed the icon will appear gray.   

4.5.6 Selection Panel 

 

 

Show All  

Reverts back to the initial model display prior to the Display Selection or 

Hide Selection being applied.  

Show Selection  

Displays only the items selected in view and hides all other model items.  

Hide Selection  

Hides only the items selected in view and displays all other model items.  
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4.5.7 Viewing Panel 

 

 

Show by Type  

Opens a dialog window for selecting items to display by type in the 

current view.  

Display Labels on Selection  

Displays selected components in the current view. To reset the view, use 

Select/Set View Items from Visibility-Display Settings.  

Display All Items  

Displays all items in the current view.  To reset the view, use Select/Set 

View Items from Visibility-Display Settings and/or Group Library to 

turn off displayed and imported CAD files.   

Displays/Hide Labels  

Displays on/off labels of components in the current view.  

4.5.8 Shading Panel 

 

 

Solid Fill  

Shades the components in the current view or selected components as a 

solid model. Control the fill and outline colors , layers and opacity from 

Modify-Modify Item Properties after selecting the components to be 

modified.  To modify single components, double-click on the component 

and use the Properties tab.  

Wire Frame  

Represents the components of the current view or seleted components as a 

wire-frame displaying only the component outline.   
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4.6 MODIFY RIBBON 

 

 

4.6.1 Properties Panel 

 

 

Items Properties  

Opens the selected item’s property dialog for modifying material, 

geometric and analytic properties associated with the component. This tool 

becomes active when an item is selected or will launch when double-

clicking a single component.  If multiple items are selected, use Modify 

Item Properties.   

Modify Selection  

Opens the Modify Item Properties dialog window to  modify or set 

selected components layer, material, geometric or analytical properties.  

This tool should be used when more than 1 item is to be modified in the 

use instance.   

4.6.2 Edit Panel 

 

 

Delete  

Deletes the current selection.  

Paste  

Inserts the clipboard contents at the insertion point.    

Cut  
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Cuts the current selection and saves to clipboard.  

Copy  

Copies the current selection and saves to clipboard.  

Undo  

Undo previous action. 

Redo  

Redo previously undone action. 

4.6.3 Copy/Move Panel 

 

 

Duplicate  

Copies the current selection and prompts the user for translation base 

reference point and insertion point.  

In Plane (Translation)  

Copies or moves the selected entities in the current plane by start and end 

vector points.  The Copy-Move dialog window will open allowing user 

input for X and Y offsets, number of copies, and options to Copy or 

Move.  

By Coordinate (Translation)  

Copies or moves the selected entities in the current plane by user offset 

input. Opens the Copy-Move dialog window allowing user input for X 

and Y offsets, number of copies, and options to Copy or Move.    

Rotation  

Rotates the selected entities in the current plane by selection of center of 

rotation and angle entry in degrees.  The Copy-Move dialog window will 

open reporting the selected rotational reference point, allowing entry for 

rotation angle, and options to Copy or Move.  Positive entry is counter-

clockwise rotation.  
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Vertical (Translation)  

Copies or moves the selected entities to other defined planes in the Z-

direction. Opens the Copy/Move Vertical dialog window allowing the 

user to: 

o Copy 

To a defined plane or Up/Down a defined number of times per user 

input.  

o Move 

To a defined plane   

o Assign 

To a defined plane  

By Layer (Translation)  

Re-assigns the current selection to a different layer. Opens the Move to 

Layer dialog window for selecting the destination layer.  To assign a new 

layer use Layer Settings in the Home ribbon.  

Reference Planes  

Copies the current plane and assigned components to create new planes in 

the model.  Use this tool to replicate typical levels vertically without 

previously creating new planes in Model – Level Assignment – Story 

Manager.   

4.6.4 Tools Panel 

 

 

Scale  

Scales up/down selected polygons by input of X and Y scale factors. This 

tool applies only to drawing items like polygons or imported CAD 

polygons. It does not apply to structural compents.  
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Mirror Selected Items  

Mirrors the selected entities in the current plane by defining a start and 

end point of the mirror axis.   

Trim Selected Items  

Trims the selected entity in the current plane by defining the line to trim to 

and the line to be trimmed.  These can be lines/edges of the selected 

components or reference lines.   

Extend Selected Items  

Extends the selected entity in the current plane by defining the line or edge 

to be extended to.  

Join  

Joins the endpoints of two selected compents by extension of the 

longitinudal axes to the point of intersection.  This tool is active when only 

2 components are selected.    

Split  

Sub-divides the selected components into user-defined input.  Graphical 

marks are shown on the component and can be snapped to.  

Unsplit  

Restores the selected components by removing all split points.  

4.6.5 Blocks Panel 

 

 

Creat Block  

Groups selected items and forms a drawing block.  Double-click on the 

items to open the block properties.  Selecting structural components and 

assigning them to a block will disable their properties as a physical 

component.   



 TOOLBARS AND DIALOG WINDOWS Chapter 4 

53 

Explode Block  

Explodes the selected block and restores the drawing and  modeling 

entities to their original state.  

4.6.6 Add/Remove Points Panel 

 

 

Insert Point  

Adds a new point to a selected item on the current plane.  This point can 

be used to control the item shape in the X and Y plane and is only active 

when a single item is selected.   

Remove Point  

Removes a point on a selected item on the current plane and is only active 

when a single item is selected.   

4.6.7 Labels Panel 

 

  

Reset Non-User Defined Labels  

Resets the labels of all components in the model back to a counter of 1 

with the “Label prefix” for each component type and for components 

whose label has not been altered by the user.  

Reset All  

Resets the labels of all components in the model back to a counter of 1 

with the “Label” prefix for each component type.  

Reset Column/Wall Stack  

Opens the dialog window for Automatic Labeling of Stacked Supports 

and resets the labels of all continuously vertical column and/or walls. 
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Applies the label at the bottom-most component in the stack to all other 

columns or walls in the stack.  
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4.7 CRITERIA RIBBON 

 

4.7.1 Material Properties Panel 

 

 

Concrete  

Opens the Material dialog window for defining concrete properties with 

or without steel fiber.   

Rebar  

Opens the Material dialog window for defining non-prestressed 

reinforcement properties.  

Prestressing  

Opens the Material dialog window for defining prestressing properties.  

Fiber  

Opens the Material dialog window for defining concrete properties with 

or without steel fiber.   

Generic  

Opens the Generic Materials dialog window for defining generic (non-

concrete) material and associated properties.  These properties can only be 

assigned to a generic component defined from Column Design – Section 

Type Manager. 
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4.7.2 Design Criteria Panel 

 

 

Design Code  

Opens the Criteria – Design Code selection options for setting the 

applicable design code and material contituative models for the design of 

slabs and beams for minimum reinforcement requirements, shear and 

flexure.  

Analysis/Design Options  

Opens the Criteria – Analysis/Design Options for defining analytical and 

design settings. Use this option to define default support conditions for 

Single- and Multi-Level modes.   

Allowable Stresses  

Opens the Criteria – Allowalbe Stresses menu for defining code required 

allowable tension and compression concrete stress and non-prestressed 

and prestressed steel stress.  Applies only to the PT design scope when 

tendons are modeled as part of a slab or beam.  For some applicable 

design codes, input of allowable crack width is also input in this dialog.  

Shear Design  

Opens the Criteria – Shear Design Options for defining one- and two-

way shear reinforcement type, size, number of legs and rails.  For two-way 

shear define the principal stress check for rr and ss axes separately or 

combined.  

Tendon Height  

Opens the Criteria – Tendon Height Defaults menu for defining the 

distance from top and bottom slab or beam surface to the CGS of tendons 

at supports and span. Use this menu to input the incremental distance for 

adjustment of the CGS from slab soffit for tendon mapping and graphical 

tendon adjustment in elevation.  
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Rebar Cover  

Opens the Criteria – Rebar Minimum Cover menu to define the top and 

bottom cover distance to non-prestressed longitudinal reinforcement.  For 

two-way slabs the distance defined is relative to the outer layer of 

reinforcement.  Open Support Lines – Design properties to define outer 

and inner layers for reinforcement of the strip. For one-way slabs and 

beams the distance defined is relative to the reinforcement parallel to the 

support line.   

Rebar Size/Material  

Opens the Criteria – Preferred Reinforcement and Material menu to 

define preferred reinforcement sizes, reinforcement material assignments 

and select a default rebar library.  Rebar libraries can be modified and 

imported/exported.  Define top and bottom flexural bar sizes for one-way, 

two-way and beam criteria and shear stirrup size for beams.   

Rebar Round-Up  

Opens the Criteria – Rebar Round Up menu options for bar length and 

spacing detailing options. Use this menu to input length and spacing 

distance rounding, bar spacing limits (RC mode only) and defining Rebar 

Library Lengths.   

Rebar Lengths  

Opens the Criteria – Reinforcement Bar Lengths menu options for 

longitudinal reinforcement cut-off lengths and bar extension lengths. Cut-

off lengths apply to minimum reinforcement over supports and in the span 

for slabs and beams.  Bar extension distance is applied to reinforcement 

required for Strength combinations (demand moments).  Options are 

available for adjusting bar lengths and position for graphical rebar output.   

4.7.3 Design Criteria (SOG) Panel 

 

 

Design Code  

Opens the Criteria – Design Code menu.  The design code for SOG mode 

is hard-coded to PTI/UBC and cannot be changed.   
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Allowable Deflection  

Opens the Criteria – Allowable Service Deflection for designating the 

deflection limition (span/deflection ratio) for the graphical check along 

design strips.  Use Result Display Settings – Design Sections to turn on 

the deflection display for support lines.   

Edge Displacements  

Opens the Criteria – Edge Displacements menu to define parameters for 

the calculation of applied displacements edge displacements.  These 

values are calculated per the PTI equation for simulating edge lift 

conditions along the edges of a slab-on-ground.   

Soil Parameters  

Opens the Criteria – Soil Parameters menu for iput of Edge and Center 

Lift values for Em (edge moisture distance) and Ym (expected vertical 

differential movement).  These values are user-defined and are only used 

in calculating the Edge Displacements.   

Tendon Height  

Opens the Criteria – Tendon Height Defaults menu for defining the 

distance from top and bottom slab or beam surface to the CGS of tendons 

at supports and span.Use this menu to input the incremental distance for 

adjustment of the CGS from slab soffit for graphical tendon adjustment in 

elevation.  

Allowable Stresses  

Opens the Criteria – Allowalbe Stresses menu for defining code required 

allowable tension and compression concrete stresses. 
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4.8 MODEL RIBBON 

 

4.8.1 Wizards Panel 

 

 

Floor Wizard  

Opens the Floor Wizard for rapid generation of a Single- or Multi-Level 

structural model with gravity loading.  Post-Tensioning can be applied 

when in RC and PT design scope.   

Frame (Beam) Wizard  

Opens the Frame (Beam) Wizard for rapid generation of Single-Level 

beam-column frames and continuous beams with gravity loading.  

4.8.2 Level Assignment Panel 

 

 

Level Assignment  

Opens the Reference Plane Manager for management of model levels.  

Use this tool to define or delete new planes and assign story heights.  
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4.8.3 Gridline Panel 

 

 

 

Gridline Wizard  

Defines model gridlines by entering vertical and horizontal gridline input 

for number, distance, angle, label, and base insertion point.   

Gridlines expanded 

 

o Gridline Wizard  

Defines model gridlines by entering vertical and horizontal gridline 

input for number, distance, angle, label, and base insertion point.   

o User Defined Gridlines 

Defines a single gridline with entry of start and endpoint.  Double-

click on the gridline to change the grid label and properties.  

o Import Gridlines from DWG 

Opens the FILE – Import options for DWG/DXF file used to 

import an Autocad grid file.  
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4.8.4 Type Manager Panel 

 

 

Section Type Manager  

Opens the Type Manager dialog for creating section types for concrete 

component design and generic section modeling.  Use this tool to create 

column design sections with reinforcement prior to Code Check/Design of 

columns.   

4.8.5 Structural Components Panel 

 

 

Slab  

Creates a slab region by graphical or coordinate entry of the slab polygon 

vertices.  Use ENTER or right-click Close/End/Accept, to close the 

polygon.  Select ESC or right-click Exit to close the command.  Double-

click on the slab to open the properties or use Modify-Item Properties to 

define the properties prior to placing the component.  

Wall  

Creates a wall by graphical or coordinate entry of the wall start and 

endpoint. Select ESC or right-click Exit to close the command.  Double-

click on the wall to open the properties or use Modify-Item Properties to 

define the properties prior to placing the component. 

o Continuous Modeling  

Continues the current operation of modeling a component by 

entering sequential endpoints of each modeled component 

segment.   
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Column  

Creates a column by graphical or coordinate entry of the column insertion 

point. Select ESC or right-click Exit to close the command.  Double-click 

on the column to open the properties or use Modify-Item Properties to 

define the properties prior to placing the component. 

Drop Panel  

Creates a drop cap/panel by graphical or coordinate entry of the drop 

cap/panel insertion point. Select ESC or right-click Exit to close the 

command.  Double-click on the drop cap/panel to open the properties or 

use Modify-Item Properties to define the properties prior to placing the 

component. 

Beam  

Creates a beam by graphical or coordinate entry of the beam start and 

endpoint. Select ESC or right-click Exit to close the command.  Double-

click on the beam to open the properties or use Modify-Item Properties 

to define the properties prior to placing the component. 

o Continuous Modeling  

Continues the current operation of modeling a component by 

entering sequential endpoints of each modeled component 

segment.   

Opening  

Creates an opening region by graphical or coordinate entry of the opening 

polygon vertices.  Use ENTER or right-click Close/End/Accept, to close 

the polygon.  Select ESC or right-click Exit to close the command.  

Double-click on the opening to open the properties or use Modify-Item 

Properties to define the properties prior to placing the component. 

Ramp  

Creates a ramp by graphical or coordinate entry of the ramp vertices. The 

first two vertices entered apply to the active plane and the last two vertices 

entered locate the ramp at the plane below active.  
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4.8.6 Isolate Panel 

 

 

Show Ramp Components  

Isolates the graphical view to show only ramps in the model. Use 

Visibility>Default Display, Visibility>View Settings, or Model>Visibility 

to restore the view of other components.  

4.8.7 Preprocessing Panel 

 

 

Connect Supports  

Establishes automatic top and bottom offsets for columns and walls.  

Nodes are offset to the connected slabs at top and bottom.  Double-click 

on the component to open Properties-Location to manually adjust offsets.   

Connect Beams to Columns and Walls  

Auto-shifts the beam to wall centerline or column endpoint.  The beam 

end must be located within the body of the wall or column to take effect.   

Align Structural Components  

Realigns the selected component based on user-defined position selection 

input.  The program will prompt user to accept the new position before 

shifting.   

Connect Drop/Cap Panel to Column  

 Shifts the drop/cap panel insertion point to the column endpoint location 

for analysis.  
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Connect with Ramp  

Truncates columns to below the ramp. Select columns and the select the 

tool. Offsets beams that are parallel or transverse to the ramp to be aligned 

along the ramp or offset below the ramp.   

4.8.8 Preprocessing (SOG) Panel (in SOG only) 

 

 

Align Structural Components  

Realigns the selected component based on user-defined position selection 

input.  The program will prompt user to accept the new position before 

shifting.   

4.8.9 Supports Panel 

 

 

Create Supports  

Automatically generates supports at far ends of walls and columns.  The 

translation and rotational fixity conditions are defined in Criteria-

Analysis/Design Options for Single- and Multi-Level modes.  The 

program generates the supports dependent on the current mode.  Use the 

Story Manager Tools at the upper-right of the Quick Access Toolbar to 

change analysis modes.  To view support symbols use Visibility-

Select/Set View Items.  

Add Point Support  

Creates a point support by graphical or coordinate entry at the support 

insertion point.  Double-click on the support to open the Properties and 

change fixity conditions.   
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Add Line Support  

Creates a line support by graphical or coordinate entry of the line support 

start and endpoint. Double-click on the support to open the Properties and 

change fixity conditions.   

o Continuous Modeling  

Continues the current operation of modeling a component by 

entering sequential endpoints of each modeled component 

segment.  

4.8.10 Springs Panel 

 

 

Add Point Spring  

Creates a point spring by graphical or coordinate entry at the spring 

insertion point.  Double-click on the spring to open the Properties and 

change sub-grade modulus (Kxx, Kyy, and Kzz) and to define a C or T 

spring.   

Add Line Spring  

Creates a line spring by graphical or coordinate entry of the line spring 

start and endpoint. Double-click on the spring to open the Properties and 

change subgrade modulus (Kxx, Kyy and Kzz) and to define a C or T 

spring.   

o Continuous Modeling  

Continues the current operation of modeling a component by 

entering sequential endpoints of each modeled component 

segment.   

Add Area Spring  

Creates an area spring region by graphical or coordinate entry of the area 

spring polygon vertices.  Use ENTER or right-click Close/End/Accept, 

to close the polygon.  Select ESC or right-click Exit to close the 

command.  Double-click on the spring to open the Properties and change 

subgrade modulus (Kxx, Kyy and Kzz) and to define a C or T spring.    
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4.8.11 Displacements Panel (in SOG only) 

 

 

Point  

Creates a point displacement by graphical or coordinate entry at the 

support insertion point.  Double-click on the support to open the Properties 

and define the displacement value.  Negative is upward.    

Line  

Creates a line support by graphical or coordinate entry of the line support 

start and endpoint. Double-click on the support to open the Properties and 

define the displacement value. Negative is upward. 

o Continuous Modeling  

Continues the current operation of modeling a component by 

entering sequential endpoints of each modeled component 

segment.   

4.8.12 Visibility Panel 

 

 

Display/Hide Slab Region Panel  

Displays on/off slab regions.  

Display/Hide Wall (N/A to SOG) 

Displays on/off walls.  

Display/Hide Column (N/A to SOG) 

Displays on/off columns.  
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Display/ Hide Drop Cap/Panel  

Displays on/off drop caps and panels.  

Display/Hide Beam   

Displays on/off beams.  

Display/Hide Opening  

Displays on/off openings.  

Display/Hide Ramps  

Displays on/off ramps.  

Display/Hide  Gridlines  

Displays on/off gridlines. 

Display/Hide Point Supports  

Displays on/off point supports.  Double-click on support to see fixity 

conditions. 

Display/Hide Line Supports  

Displays on/off line supports. Double-click on support to see fixity 

conditions.  

Display/Hide Point Springs (N/A to SOG) 

Displays on/off point springs.  Double-click on spring to see sub-grade 

moduli settings for Kxx, Kyy and Kzz and to set compression or tension 

spring type. 

Display/Hide Line Springs  (N/A to SOG) 

Displays on/off line springs.  Double-click on spring to see sub-grade 

moduli settings for Kxx, Kyy and Kzz and to set compression or tension 

spring type.  

Display/Hide Area Springs  

Displays on/off area springs.  Double-click on spring to see sub-grade 

moduli settings for Kxx, Kyy and Kzz and to set compression or tension 

spring type. 
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Point Displacement  (SOG only) 

Displays on/off point displacements. 

Line Displacement  (SOG only) 

Displays on/off line displacements. 

4.8.13 Properties Panel 

 

 

Items Properties  

Opens the selected item’s property dialog for modifying material, 

geometric and analytic properties associated with the component. This tool 

becomes active when an item is selected or will launch when double-

clicking a single component.  If multiple items are selected, use Modify 

Item Properties.   

4.8.14 Transform Panel 

 

 

Transform Slab  

Creates a slab region from a selected polygon.  The polygon can be 

natively drawn using Home-Draw tools or by import of a .DWG or .DXF 

file.   

Transform Beam  

Creates a beam component from a selected polygon.  The polygon can be 

natively drawn using Home-Draw tools or by import of a .DWG or .DXF 

file.   
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Transform Opening  

Creates an opening from a selected polygon.  The polygon can be natively 

drawn using Home-Draw tools or by import of a .DWG or .DXF file.   

Transform Column  

Creates a column component from a selected polygon.  The polygon can 

be natively drawn using Home-Draw tools or by import of a .DWG or 

.DXF file.   

Transform Drop Cap/Panel  

Creates a drop cap/panel component from selected polygon.  The polygon 

can be natively drawn using Home-Draw tools or by import of a .DWG or 

.DXF file.   

Transform Lines to Polygon  

Creates a polygon from a group of selected lines.  The polygon can then 

be transformed to a component using other transformation tools.  

Transform Single Wall  

Creates a single wall component from a selected polygon.  The polygon 

can be natively drawn using Home-Draw tools or by import of a .DWG or 

.DXF file.   

Transform Compound Wall  

Creates multiple wall components from a selected polygon.  The polygon 

can be natively drawn using Home-Draw tools or by import of a .DWG or 

.DXF file.   
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4.9 LOADING RIBBON 

 

4.9.1 Load Combo Panel 

 

 

Load Cases  

Opens the Load Case Library options for creating, deleting and 

modifying General/Lateral Loads, Building Loads, and Lateral Load 

Solution Sets.  The following defines each load type: 

o General/Lateral  

Used for gravity load cases, temperature and shrinkage loads, and 

applied lateral reactions transferred to a slab or beam. Only general 

load case types can be assigned as Reducable. These load cases 

are solved for in Single- and Multi-Level mode.  

o Building 

These are Wind, Seismic or Generic Lateral Loads applied to a 

global structure and reacted by the lateral load resisting system.  

Building loads can be created by use of Loading Wizards, created 

manually or imported through the ADAPT-Integration Console 

and are only solved for when in Multi-Level mode.  Building load 

case reactions are available to be applied to a Single-Level 

analysis.   

o Lateral Load Solution Sets 

These are imported reactions to a Single-Level model from the 

ADAPT-Integration Console and checked for placement 

compatability and equilbrium.   

Load Combinations  

Opens the Combinations input menu for creating, deleting and modifying 

load combinations. Default load combinations will be created per the 
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selection of Design Code from the Criteria panel. Each load combination 

is set an Analysis/Design Options type.  The following defines each type: 

o Service 

Applies the serviceability requirements (allowable stress, 

minimum reinforcmeent, etc.) for the selected design code and 

criteria and to the model design sections for the defined load 

combination.  Multiple service conditions may be evaluated, 

including Total, Sustained, Frequent, QP, etc.   

o Strength 

Uses the factored, ultimate design actions for the model design 

sections and determines reinforcement required necessary to 

produce section capacity > demand.   

o Initial 

Applies to models including prestressing. The program checks the 

concrete stress against the allowable initial stress at transfer and 

calculates necessary supplemental reinforcement.   

o Cracked Deflection 

This type is used only to evaluate the slab for cracking and loss of 

stiffness for the combination.  This requires the user to perform 

analysis, design the design sections and use Floor Design-

Cracked Deflection to run the cracked deflection check. This 

check only applies to Single-Level mode.  

o No Code Check  

This is used to evaluate results for the load combination but the 

program will produce no code checks or reinforcement.   

o Long-Term Deflection 

This type is used to combine the effects of other load combinations 

and produce a result.  It is commonly used to combine the results 

of multiple Cracked Deflection combinations to produce long-

term predicted deflections.   
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4.9.2 LL Reduction Panel 

 

 

Reduction Settings  

Opens the Live Load Reduction Factors table for reduction method, area 

and factors, application settings.  These reduction factors apply only to 

reduction of loads tagged as Reducible from Loading-Load Case 

Library. The reduction factor calculation is dependent on creation of 

tributary regions from Loading-Tributary Load Manager.  Load 

Reduction Factors are applied only in two ways: 

o Column Design 

Go to Column Design-Column Design Options.  If set to YES 

the reduced loads will be applied for column design.  

o Analysis of Single-Level  

If a Multi-Level analysis has been performed, reactions can be re-

applied in Single-Level mode with inclusion of load takedown (Fz 

reactions).  Go to Analysis-Analyze Structure and use the option 

to Apply Live Load Reduction.    

4.9.3 General Panel  

 

 

Add Point Load  

Creates a point load by graphical or coordinate entry of the load insertion 

point. Select ESC or right-click Exit to close the command. Double-click 

on the load to input the load value or use Modify-Item Properties to 

define the load prior to placement. 
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Add Line Load  

Creates a line load by graphical or coordinate entry of the load start and 

endpoint. Select ESC or right-click Exit to close the command.  Double-

click on the load to input the load value or use Modify-Item Properties to 

define the load prior to placement.  

o Continuous Modeling  

Continues the current operation of modeling a component by 

entering sequential endpoints of each modeled component 

segment.   

Add Patch Load  

Creates a patch load region by graphical or coordinate entry of the load 

polygon vertices.  Use ENTER or right-click Close/End/Accept, to close 

the load region.  Select ESC or right-click Exit to close the command.  

Double-click on the load to input the load value or use Modify-Item 

Properties to define the load prior to placement. 

Line Load Wizard  

Opens the Create Line Load Automatically dialog to select the General 

load case and define the load value.  Requires selection of at least one slab 

or polygon to map load input to the perimeter of the region selected.  

Patch Load Wizard  

Opens the Create Patch Load Automatically dialog to select the 

General case load and define the load value.  Requires selection of at least 

one slab or polygon to map load input to the region.   

Import Loads (from XLS file)  

Opens the XLS Import Wizard used to import point and line loads into 

the current plane.     
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4.9.4 Lateral/Building Panel 

 

 

Wind Load Wizard  

Opens the Wind Load Wizard dialog for auto-generation or manual input 

of code-required wind load parameters or surface pressure.  Wind 

pressures are converted to externally applied, modifiable line loads at slab 

edges. Wind load cases produced by the wizard are stored as Building 

Loads and solved for when in Multi-Level mode.  

Seismic Load Wizard  

Opens the Seismic Load Wizard dialog for auto-generation or manual 

input of lateral-static code-required seismic load parameters, story forces 

or base shear.  When automatic generation is used, the program calculates 

base shear, story forces and moments.  At the time of analysis, the story 

forces and moments are applied as nodal forces and moments proportioned 

based on nodal mass over total story mass.  Seismic load cases produced 

by the wizard are stored as Building Loads and solved for when in Multi-

Level mode. 

Lateral Load Wizard   

Opens the Lateral Load Wizard dialog for manual input of story forces. 

At the time of analysis, the story forces and moments are applied as nodal 

forces and moments proportioned based on nodal mass over total story 

mass.  Generic lateral load cases produced by the wizard are stored as 

Building Loads and solved for when in Multi-Level mode. 

Lateral Reactions  

Opens the Generate Lateral Point Loads for manual input of column and 

wall end joint reactions for lateral load cases. This option requires that the 

loads input be in equilibrium with applied loads and compatible with 

locations of vertical, lateral-resisting elements.  This option applies only to 

Single-Level mode.  
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4.9.5 Tributary Panel 

 

  

Load Takedown  

Opens the Tributary Load Manager dialog for creation of tributary 

regions of vertical elements and level and cumulative areas and loads. 

Tributary Loads are not dependent on the finite element solution and can 

be re-applied as reactions in Single-Level mode or when designing 

columns and walls.   

4.9.6 Pattern Panel 

 

 

Sub-regions  

Use this option to create multiple sub-regions of a slab to select and 

include as part of a load pattern.  Input regions by creating polygons or by 

select divisible lines in both orthogonal directions. Sub-regions should be 

created in Single-Level mode but can be applied to multiple planes in a 

model.  

Load Patterns  

Opens the Skip Patterns dialog for defining a load case to be patterned 

and creating load patterns called “Pattern_1, Pattern_2,…Pattern_N.”  Use 

this option in Single-Level mode and select the sub-regions to be included 

in the pattern and select ADD. Load patterns will be added to the 

Loading-Load Combinations dialog menu and can be added to 

combinations.   
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4.9.7 Visibility Panel 

 

 

Show Loads  

Displays on/off loads.  If selective loads are in view from Select/Set View 

Items or Layer Settings, when selected the visible loads will turn off.  If 

selected again, all loads assigned to model will turn on.   

Show Point Loads  

Displays on/off all point loads. If selective loads are in view from 

Select/Set View Items or Layer Settings, when selected the visible loads 

will turn off.  If selected again, all loads assigned to model will turn on.   

Show Line Loads  

Displays on/off all line loads. If selective loads are in view from 

Select/Set View Items or Layer Settings, when selected the visible loads 

will turn off.  If selected again, all loads assigned to model will turn on.   

Show Area Loads  

Displays on/off all area loads. If selective loads are in view from 

Select/Set View Items or Layer Settings, when selected the visible loads 

will turn off.  If selected again, all loads assigned to model will turn on.   

View Load Settings  

Opens the graphical display settings for loading.  Controls font and 

symbol sizes for loading 
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View Load Reports 

 

 
 

Load Cases and Combinations  

Generates a .RTF file with load cases and combinations defined in 

the model.  

Skip Pattern  

Generates a .RTF file listing pattern loads with included sub-

regions, skip factors and load reduction factors.  

Applied Loads  

Generates a .RTF file with coordinates, load magnitudes and 

parameters (Seismic) for all applied loads in the model.   

Dead Load  

Displays a plan view of all modeled Dead loads and magnitude for 

the current level.    

Live Load  

Displays a plan view of all modeled Live loads and magnitude for 

the current level.    

User Defined Load Cases  

Displays a plan view of all modeled user-defined General load 

case loads and magnitude for the current level.  
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Column Tributary  

Opens a .XLS file containing tributary area, load and FEM reaction 

information for solved load cases.    

Tributary Load Check  

Opens a .XLS file containing tributary load validation check for 

equilibrium.  
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4.10 TENDON RIBBON  

 

4.10.1 Criteria Panel 

 

 

Prestressing  

Opens the Material dialog window for defining prestressing properties.  

Allowable Stresses  

Opens the Criteria – Allowalbe Stresses menu for defining code required 

allowable tension and compression concrete stress and non-prestressed 

and prestressed steel stress.  Applies only to the PT design scope when 

tendons are modeled as part of a slab or beam.  For some applicable 

design codes, input of allowable crack width is also input in this dialog.  

Tendon Height  

Opens the Criteria – Tendon Height Defaults menu for defining the 

distance from top and bottom slab or beam surface to the CGS of tendons 

at supports and span. Use this menu to input the incremental distance for 

adjustment of the CGS from slab soffit for tendon mapping and graphical 

tendon adjustment in elevation.  

4.10.2 Settings Panel 
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Tendon Settings  

Opens the Tendon Settings dialog menu to control modeling parameters 

and tolerances for tendons.  Use this to disable spline tendon modeling and 

default to linearized tendon input.   

4.10.3 Model Panel 

 

 

Add Tendon  

Adds a single tendon to the structure by graphical or coordinate input of 

tendon anchor and high point (control point) locations. The default tendon 

shape reverse parabolic. Select ESC or right-click Exit to close the 

command. Double-click on the tendon to modify Tendon Properties.  

Map Distributed  

Maps a selected “master” tendon over a region by selection of master 

tendon nodes to user-specified locations.  Define the master tendon first, 

double-click to open the Map Distributed Tendon dialog menu and 

select coordinates 1 of N for mapping.  

Map Banded  

Maps tendons to selected design strips for the user-defined criteria set in 

the Map Banded Tendons dialog menu.  Design strips are required to be 

generated before mapping.   

4.10.4 Modify Panel 

 

 

Tendon Editor  

Opens the Dynamic Tendon Editor for rapid modification of tendon 

CGS, number of strands, anchorage, and spline override. Use Top View in 

Single-Level mode for recommended use.   
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Trim/Extend Tendons  

Auto-adjusts tendon anchor locations to the slab edge. Use Tendon-

Tendon Settings to adjust the tolerance distance.   

Insert Point  

Adds a new control point to the selected tendon on the current plane. Use 

this to create a new tendon span on an existing tendon. 

Remove Point  

Removes a control point on a selected tendon on the current plane and is 

only active when a single tendon is selected. Use this to remove a span 

from an existing tendon.    

Insert Swerve Point  

Adds a swerve point to the selected tendon on the current plane. Use the 

swere point to control lateral curvature in the tendon span where inserted 

in the XY plane.  A maximum of 3 swerve points can be added to a span.    

Remove Swert Point  

Removes a swerve point on the selected tendon on the current plane. Use 

the swere point to control lateral curvature in the tendon span where 

inserted in the XY plane.  A maximum of 3 swerve points can be added to 

a span.    

4.10.5 Shop Drawing Panel (add-on Module) 

 

 

Friction and Elongation  

Calculates friction loss and elongation for tendons set to Calculated 

Force option in Tendon Properties – Settings.  Select tendons and then 

the tool to perform the calculations.   

Felt 3D Report  

Produces combined prestress short- and long-term loss and elongation 

report for tendons set to the “Calculate Force” method. 
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Single Strand 

Option to report losses as a function of a single strand when the number of 

strands designated exceeds 1. 

Drawing Editor  

Contains tools for modeling and drawing customization of tendons for 

shop drawing production including general tools, chair grouping, tendon 

color representation and construction joints.   

Tools – Options provided to edit modeled tendons. Including: 

Converting tendons from straight or spline 

representation to fillet-radius representation.  The 

default radius for in-plane swerve locations is 20ft (6m) 

as set in the the individual Tendon Properties menu and 

from Modify>Modify Selection>Tendons.   

Removal of all non-auto swerve points on spline or 

fillet-radius tendons.  Auto swerve points are added to 

anchorage locations of tendons with a default offset.  

Update of tendon and construction joint intersections 

when a tendon and/or construction joint is removed or 

relocated.  

Chair Groups – Options provided for support bar spacing and 

support bar extension each side of the control location. After 

entering the value, tendon locations that can be edited will be 

enabled with a yellow circle.  Select the location and Apply the 

values set.  The program will report the support bar height and 

number of spaces with spacing dimension.  

Colors – Provides options to group tendons by customized colors 

for shop drawing production.  
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Construction Joints – Options provided for drawing construction 

joints as discontinuous and continuous (with varying anchor 

options) and pour sides and labels relative to the modeled joints.  

The joints are used to virtualize tendon loss and elongation 

calculations relative to the joint type and location.   

Display Tendon Heights  

Opens the Tendon Chair dialog to input display parameters for tendon 

chair heights.  Use Visibility – Select/Set View Items to change the 

symbol and text height.  

Tendon Spacing Tool  

Creates spacing dimensions between selected tendons at a user-specified 

insertion point.  

4.10.6 Visibility Panel 

 

 

Tendon Display Manager  

Opens the Tendon Display Information dialog for selection of tendon 

properties, curvature, stressing and geometry to be displayed.  Use 

Visibility – Select/Set View Items to change the symbol and text height.  

Display/Hide Tendons  

Displays on/off tendons. 

Tendon Intersection Detector  

Detects the intersection of two or more tendons in the structure and marks 

the intersection points.   

Display/Hide Radius of Curvature  

Displays on/off the radius of curvature of the tendons end, high and low 

points in display and marks as NG or OK based on minimum radius set in 

the tendon properties dialog.    
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Display Tendon Elevation  

Creates tendon elevations for the selected tendons at the user-defined 

insertion point.   

4.10.7 Design Panel 

 

 

Tendon Optimizer  

Opens the Tendon Optimizer dialog for optimization of tendon design for 

P/A, %bal load and allowable stresses for the selected tendons within a 

span. Intended for Single-level use and the level should be analyzed first.  

Open the Tendon Optimizer and select tendons in the span to be 

optimized.   
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4.11 REBAR RIBBON 

 

4.11.1 Design Criteria Panel 

 

 

Rebar Cover  

Opens the Criteria – Rebar Minimum Cover menu to define the top and 

bottom cover distance to non-prestressed longitudinal reinforcement.  For 

two-way slabs the distance defined is relative to the outer layer of 

reinforcement.  Open Support Lines – Design properties to define outer 

and inner layers for reinforcement of the strip. For one-way slabs and 

beams the distance defined is relative to the reinforcement parallel to the 

support line.   

Rebar Size/Material  

Opens the Criteria – Preferred Reinforcement and Material menu to 

define preferred reinforcement sizes, reinforcement material assignments 

and select a default rebar library.  Rebar libraries can be modified and 

imported/exported.  Define top and bottom flexural bar sizes for one-way, 

two-way and beam criteria and shear stirrup size for beams.   

Rebar Round-Up  

Opens the Criteria – Rebar Round Up menu options for bar length and 

spacing detailing options. Use this menu to input length and spacing 

distance rounding, bar spacing limits (RC mode only) and defining Rebar 

Library Lengths.   

Rebar Lengths  

Opens the Criteria – Reinforcement Bar Lengths menu options for 

longitudinal reinforcement cut-off lengths and bar extension lengths. Cut-

off lengths apply to minimum reinforcement over supports and in the span 
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for slabs and beams.  Bar extension distance is applied to reinforcement 

required for Strength combinations (demand moments).  Options are 

available for adjusting bar lengths and position for graphical rebar output.   

4.11.2 Model Base Rebar Panel 

 

 

Mesh  

Creates a mesh reinforcement region by graphical or coordinate entry of 

the mesh polygon vertices.  Use ENTER or right-click 

Close/End/Accept, to close the polygon.  Select ESC or right-click Exit 

to close the command.  Double-click on the mesh symbol to modify mesh 

properties or use Modify-Item Properties prior to placement. Slabs of 

varying offsets should be assigned unique mesh reinforcement regions. 

Mesh Wizard  

Opens the Create Mesh Reinforcement Automatically dialog to select 

the reinforcement position, CGS, and bar area or size and spacing. 

Requires selection of at least one slab or polygon to map load input to the 

region.  Slabs of varying offsets should be assigned unique mesh 

reinforcement regions.  

Banded  

Creates banded (grouped) rebar by graphical or coordinate entry of the 

rebar start and endpoint. Select ESC or right-click Exit to close the 

command.  Double-click on the rebar to input  properties or use Modify-

Item Properties prior to placement. 

Distributed  

Creates distributed rebar by graphical or coordinate entry of the rebar start 

and endpoint and distribution range. Select ESC or right-click Exit to 

close the command.  Double-click on the rebar to input properties or use 

Modify-Item Properties prior to placement. 
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4.11.3 Generate Panel 

 

 

Calculated Rebar Plan  

Opens the Generate Rebar Drawing Options dialog to select 

combinations, bar length selection and orientation for graphical display of 

calculated reinforcement for X and Y design strips at top and bottom 

locations.   

4.11.4 Visibility Panel 

 

 

Display Manager  

Opens the Rebar Display Manager dialog to select rebar graphical 

display options for calculated and base strip and mesh reinforcement.   

Display/Hide All Rebar  

Displays on/off all reinforcement. 

4.11.5 Reporting Panel 

 

 

Print Settings  

Opens the Rebar Plot Settings dialog to configure the rebar appearance 

settings for printing.  
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Export Settings  

Opens the DWG/DXF Export Settings For Reinforcement dialog to 

configure the rebar appearance settings for export to AutoCAD files.     
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4.12 ANALYSIS RIBBON 

 

4.12.1 Vibration Panel 

 

 

Settings  

Opens the Vibration Combinations dialog for defining load 

combinations, number of modes, and direction stiffness contribution 

factors Rx, Ry, and Rz to be used in evaluating the structure dynamically 

for modal frequencies, periods and amplitude. This option is used in 

Single-Level analysis for evaluation of slab sensitive to rhythmic 

movement. These combinations are also used for determining mass for the 

Seismic and Lateral Load Wizards.   

4.12.2 Meshing Panel 

 

 

Node Proximity Detection  

Detects and displays location where the distance between 2 nodes is less 

than the suggested cell size.    

Shift Nodes Automatically  

Shifts 2 or more physical component nodes within the specified distance 

to an analytical node.  
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Display/Hide Components Representative  

Turns on/off the Component Representative layer.  This layer displays 

physical endpoint, centerline, and edge locations for producing a manual 

mesh or shifting nodes manually between components.   

Shift Nodes Manually  

Shifts the node of a selected component to a selected location.  The new 

location is updated when Automatic Mesh is performed.   

Cancel Node Shift  

Resets automatic or manual node shift values of components to zero for 

the selected mode, Single- or Multi-Level.  To modify a single component, 

double-click and use the FEM tab.   

Exclude Meshing  

Creates region by graphical or coordinate entry of the polygon vertices to 

exclude or include-only for automatic meshing.  Use ENTER or right-

click Close/End/Accept, to close the polygon.  Select ESC or right-click 

Exit to close the command.  Double-click on the polygon to for the 

excluder properties.  

Manual Mesh Generation  

Use for manually meshing the slab by input of element edges on 

horizontal and vertical sides. Select the slab region and select the option. 

Use in Single-Level mode.  

Erase Mesh  

Removes the automatic or manual mesh currently in place in Single- or 

Multi-Level mode.   

Mesh Generation  

Opens the Automatic Mesh Generation Dialog dialog to select meshing 

method, cell size and shape, and node consolidation options. Select Mesh 

Slabs to produce slab mesh before analysis. Walls are meshed as part of 

the analysis run.   
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4.12.3 Analysis Panel 

 

 

Execute Analysis  

Opens the Analysis Options dialog to run the analysis for the selected 

mode of operation in Single- or Multi-Level mode. You can specify 

Analysis Options in this window prior to analysis.  

Analysis Options  

Opens the Analysis Options dialog to select and save analysis options, 

load combinations to be processed, usage case to be considered and Global 

(Multi-Level) analysis results to be considered when analyzing in Single-

Level mode.  

Cracked Deflection  

Processes the cracked deflection check for combinations set to Cracked 

Deflection. This requires the user to perform analysis and design the 

design sections. This check only applies to Single-Level mode. 

Result Display Settings  

Opens/Closes the Result Display Settings panel for load selection and 

settings of graphical analysis and design results.   

View Analysis Results  

Opens the ADViewer for graphical FEM analysis results.  

Numerical Display  

Diplays numerical values at each element node or design section for the 

selected graphical result in Result Display Settings.  

Results Scale Down  

Reduces the graphical results scale ordinate.  

Default Results Scale  
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Resets the graphical results scale ordinate to the program default relative 

to max/min values on the element or design strip.  

Results Scale Up  

Increases the graphical results scale ordinate.  

4.12.4 Contour Settings Panel 

 

 

Display Contours  

Displays on/off line contours for FEM slab and wall graphical results.  

Increase Number of Contour Lines  

Increases the number of contour lines for the graphical display of FEM 

slab and wall graphical results. Active only when gradient contours are 

active from Result Display Settings – Settings – Contour Settings.  

Decrease Number of Contour Lines  

Decreases the number of contour lines for the graphical display of FEM 

slab and wall graphical results.  Active only when gradient contours are 

active. Result Display Settings – Settings – Contour Settings. 

Display/Hide Text on Line Contours  

Displays on/off text values for contour lines of FEM slab and wall results.  

4.12.5 Warping Panel 
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Display/Hide Contour Warping  

Displays on/off a warped view of the selected FEM slab or wall  graphical 

contour results.    

Increase Warping Scale  

Increases the warping scale of the selected warped graphical result.  

Decrease Warping Scale  

Decreases the warping scale of the selected warped graphical result. 

4.12.6 Reactions Panel 

 

 

Stored Reactions  

Opens the Reaction Manager to view or delete stored Global (Multi-

Level) and Single-Level load case and combination reactions for each 

Usage Case.  

4.12.7 Visibility Panel 

 

 

Display/Hide Analysis Elements  

Displays on/off shell and frame elements and analysis nodes for the 

current view.  The model requires meshing before display is available.  

Display/Hide Nodes    

Displays on/off all analysis nodes in the current view.  The model requires 

meshing before the display is available.  
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Display/Hide Frame Elements  

Displays on/off frame elements for columns and beams for the current 

view. The model requires meshing and saved analysis results before 

display is available.  

Display/Hide Shell Elements  

Displays on/off shell elements for slabs and walls for the current view.  

The model requires meshing before display of slab elements is available 

and analysis before display of the wall elements is available.  

Display/Hide Excluder  

Displays on/off slab excluder polygons for the current view. To view 

excluder with mesh inside or outside of excluder region, mesh the slab and 

use Display/Hide Shell Elements.  
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4.13 FLOOR DESIGN RIBBON 

 

4.13.1 Punching Shear Panel 

 

 

Shear Design  

Opens the Shear Design Criteria tab where the user can setup the shead 

design properties and settings such as reinforcement type and size. 

Execute Shear Check  

Performs the punching shear check for columns and qualifying walls at the 

current plane.  This option is only operable in Single-Level mode after 

Single- or Multi-Level analysis has been performed. After a user executes 

a shear check the results are available in the Results Viewer. A strength 

combination must be selected in order to activate the Punching Shear 

results. 

4.13.2 Strip Modeling Panel 

 

 

Create X-Direction Support Line  

Adds a support line to the structure by graphical or coordinate input of the 

support line vertices.  Select ESC or right-click Exit to close the 

command.  Double-click on the support line to modify Support Line 

Properties and assign the support line in X-direction.  
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Create Y-Direction Support Line  

Adds a support line to the structure by graphical or coordinate input of the 

support line vertices.  Select ESC or right-click Exit to close the 

command. Double-click on the support line to modify Support Line 

Properties and assign the support line in Y-direction. 

Dynamic Editor  

A new and improved Strip Modeling Dynamic Editor includes tools used 

to more rapidly model and modify support lines and design strips.  These 

include: 

Support Line Wizard – creates a support based on a construction 

line defined by snap points along the strip path. 

Support Line Limits – Changes selected support line design 

criteria and tributary limits for the design strip.  

Wall – allows the user to set constraints for how walls are 

considered for design strip generation.  

Display - Sets the support line display for Direction, Criteria and 

Width Limit 

Create X-Direction Splitter  

Adds a splitter to the structure by graphical or coordinate input of the 

support line vertices.  Select ESC or right-click Exit to close the 

command. Double-click on the splitter to modify Support Line 

Properties and assign as X-direction. X-Direction is indicated by circular 

symbol on vertices.  

Create Y-Direction Splitter  

Adds a splitter to the structure by graphical or coordinate input of the 

support line vertices.  Select ESC or right-click Exit to close the 

command. Double-click on the splitter to modify Support Line 

Properties and assign as Y-direction. Y-Direction is indicated by square 

symbol on vertices. 
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Extend Support Lines to Slab Boundaries  

Auto-adjusts the selected support line/s end-points to the nearest slab 

edge.  

Create Support Line Tributary Region  

Creates a tributary region assigned to a support line by graphical or 

coordinate entry of the polygon vertices. Select the support line and then 

the tool.  Use ENTER or right-click Close/End/Accept, to close the 

polygon.  Select ESC or right-click Exit to close the command.  

4.13.3 Section Design Panel 

 

 

 

Create Manual Design Section  

Creates a manual design section by graphical or coordinate entry of the 

load start and end-point. 

Generate Sections New  

Auto-generates tributary regions and design sections relative to the 

modeled support lines and associated properties. This option will erase 

manual tributary regions.  

Generate Sections Existing  

Generates design sections for user-defined tributary regions and modified 

tributary regions auto-generated by the program.  

Design the Sections  

Processes the design of manual and auto-generated design sections for the 

selected design code and criteria and selects Calculated Reinforcement 

to satisfy code checks for the processed combinations.  



Chapter 4 TOOLBARS AND DIALOG WINDOWS  

98 

Investigate the Sections  

Processes the flexural capacity of manual and auto-generated design 

sections for user-defined Base Reinforcement including post-tensioning 

when modeled.  

Delete Design Strips  

Erases auto-generated and manually created design strips (tributary 

regions) and design sections.    

4.13.4 Rebar Panel 

 

 

Generate Rebar  

Opens the Generate Rebar Drawing Options dialog to select 

combinations, bar length selection and orientation for graphical display of 

calculated reinforcement for X and Y design strips at top and bottom 

locations.   

4.13.5 Tools Panel 

 

 

Open BuilderSum  

Opens the support lines results in the results interface BuildSum for 

viewing combination and envelope stresses, force and reinforcement 

diagrams and design summary.  
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4.13.6 Steel FRC Panel (MAT Only) 

 

 

FRC Non-Linear Parameters  

Opens the dialog windows for calculating non-linear parameters for load 

transfer over joints, load regions and joint spacing.  Applies to MAT mode 

only when a fiber material is assigned in Criteria-Concrete and the Non-

Linear option is selected.  

4.13.7 Strip Results/Visibility Panel 

 

 

Display Strip Results  

Opens the ADAPT Solid Modeling Viewer.  This tool is used to 

dynamically view the model components, imported CAD drawings, and 

view displacements and deformations.    

Results Scale Down  

Reduces the graphical results scale ordinate.  

Default Results Scale  

Resets the graphical results scale ordinate to the program default relative 

to max/min values on the element or design strip.  

Results Scale Up  

Increases the graphical results scale ordinate.  

Numerical Display  

Diplays numerical values at each element node or design section for the 

selected graphical result in Result Display Settings.  
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Display Max/Min Values  

Shows the maximum and minimum values of the selected results. 

Perpendicular Projection  

When selected, displays the selected graphical design strip or beam 

element result from Result Display Settings in the XY plane. Use Top 

View for results display.   

Display Manual Design Sections  

Toggles on/off the display of manual design sections.  

Display Design Sections  

Displays off/on design sections along support lines and is dependent on 

the selection made for All Section, X direction or Y direction within this 

tool panel. To generate design sections, go to Floor Design-Section 

Design-Generate Design Sections. This display is ON by default when 

sections are generated.  

Display/Hide Support Lines  

Displays on/off support lines assigned to X and Y directions.  If Display 

Design Sections is active and sections have been generated from Floor 

Design-Section Design, support lines and design sections will appear. 

Support lines and sections will be displayed by default for both directions 

when they are generated. 

Display/Hide Support Lines in X-Direction  

Displays on/off support lines assigned to X direction. If Display Design 

Sections is active and sections have been generated from Floor Design-

Section Design, support lines and design sections will appear. 

Display/Hide Support Lines in Y-Direction  

Displays on/off support lines assigned to Y direction. If Display Design 

Sections is active and sections have been generated from Floor Design-

Section Design, support lines and design sections will appear. 

Display/Hide Splitters  

Displays on/off splitters assigned to X and Y directions.  
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Display/Hide Splitters in X-Direction  

Displays on/off splitters assigned to X direction. 

Display/Hide Splitters in Y-Direction  

Displays on/off splitters assigned to Y direction. 

Display/Hide Support Line Tributaries  

Displays on/off tributary regions for support lines with colored polygons 

and is dependent on the selection made for X and Y direction, X direction 

only or Y direction only within this tool panel. Tributaries are generated 

when design sections are generated from Floor Design-Section Design-

Generate Design Sections, but are hidden in display by default.  

Display/Hide Support Line Tributaries X-direction  

Displays on/off tributary regions assigned to X direction. If Generate 

Design Sections from Floor Design-Section Design has been performed, 

tributary regions will not be shown by default.   

Display/Hide Support Line Tributaries Y-direction  

Displays on/off tributary regions assigned to Y direction. If Generate 

Design Sections from Floor Design-Section Design has been performed, 

tributary regions will not be shown by default. 
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4.14 PT/RC EXPORT RIBBON 

 

4.14.1 Material Properties Panel 

 

 

Concrete Material Properties for Strip Method  

Opens the Concrete (Strip Method) dialog window for defining concrete 

properties exported to ADAPT-PT/RC..    

Mild Steel Material Properties for Strip Method  

Opens the Mild Steel (Strip Method) dialog window for defining mild 

steel properties exported to ADAPT-PT/RC. 

Prestressing Material Properties for Strip Method  

Opens the Prestressing (Strip Method) dialog window for defining post-

tensioning properties exported to ADAPT-PT/RC.  

4.14.2 Design Criteria/Settings Panel 

 

 

Tendon Height Defaults  

Opens the Criteria – Tendon Height Defaults for Strip Method menu 

for defining the distance from top and bottom slab or beam surface to the 

CGS of tendons at supports and span exported to ADAPT-PT/RC.   
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ffective Width  

Gives option to consider the effective flange width in ADAPT-PT/RC 

when Beam design criteria is set in the Criteria-Design Code.  

Loading Treatment Options  

Sets the loading treament options for LL skipping, Self-weight 

consideration and live load reduction  when exporting strips to ADAPT-

PT/RC.  

PT or RC Design Options  

Sets general PT or RC (depending on scope selected in opening splash 

screen) design options when exporting a strip to ADAPT-PT/RC.  

4.14.3 Load Factors Panel 

 

 

Load Combinations for Export to ADAPT-RC (RC Only Mode)  

Sets the load combination factors to be used when exporting a strip to 

ADAPT-RC.   

 Load Combinations for Export to ADAPT-PT (PTRC Mode)  

Sets the load combination factors to be used when exporting a strip to 

ADAPT-PT.     

4.14.4 Strip Modeling Panel 

 

 

Support Line Wizard  

Opens a dialog window for setting parameters for auto-generation of 

support lines. This requires the user to specify the start and endpoint of a 

scanning band for selection of support line vertices.  
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Create X-Direction Support Line for Strip Method  

Adds a support line to the structure by graphical or coordinate input of the 

support line vertices.  Select ESC or right-click Exit to close the 

command.  Double-click on the support line to modify Support Line 

Properties and assign the support line in X-direction.  

Create Y-Direction Support Line for Strip Method  

Adds a support line to the structure by graphical or coordinate input of the 

support line vertices.  Select ESC or right-click Exit to close the 

command. Double-click on the support line to modify Support Line 

Properties and assign the support line in Y-direction. 

Create X-Direction Splitter for Strip Method  

Adds a splitter to the structure by graphical or coordinate input of the 

support line vertices.  Select ESC or right-click Exit to close the 

command. Double-click on the splitter to modify Support Line 

Properties and assign as X-direction. X-Direction is indicated by circular 

symbol on vertices.  

Create Y-Direction Splitter for Strip Method  

Adds a splitter to the structure by graphical or coordinate input of the 

support line vertices.  Select ESC or right-click Exit to close the 

command. Double-click on the splitter to modify Support Line 

Properties and assign as Y-direction. Y-Direction is indicated by square 

symbol on vertices. 

Extend Support Lines to Slab Boundaries  

Auto-adjusts the selected support line/s end-points to the nearest slab 

edge.  

Create Support Line Tributary Region for Strip Method  

Creates a tributary region assigned to a support line by graphical or 

coordinate entry of the polygon vertices. Select the support line and then 

the tool.  Use ENTER or right-click Close/End/Accept, to close the 

polygon.  Select ESC or right-click Exit to close the command.  

Connect Support Lines to Columns and Walls  

Auto-connects support line vertices to walls and columns if a vertex is 

located on a column or wall. For Strip  Method export to PT/RC support 

lines vertices must be at a support centroid or end-point.  
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Create Strip Method Load Transfer  

Creates a point support at user-defined location for a selected support line 

by graphical or coordinate entry where one support line is supporting 

another and both are exported to ADAPT-PT/RC by Strip Method. This 

would be used for beam-supporting beam.   

4.14.5 Design Strips Panel 

 

 

Generate Design Strips for Strip Method  

Auto-generates tributary regions (design strips) relative to the modeled 

support lines for export to ADAPT-PT/RC.  

Delete Design Strips  

Erases auto-generated and manually created design strips (tributary 

regions) and design sections.    

4.14.6 Export Panel 

 

 

Execute ADAPT-PT/RC  

Opens the selected design strip in ADAPT-PT/RC.   

Import Tendons from ADAPT-PT  

Imports tendons for design strips exported to ADAPT-PT and solved for 

without unlocking the PT model.  Imports for design strips or all design 

strips.  

Generate Input Data for ADAPT-PT/RC  

Auto-generates and stores the .adb input files for all design strips to be 

executed within ADAPT-PT/RC.  
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4.15 COLUMN DESIGN RIBBON 

 

4.15.1 Type Manager Panel 

 

 

Section Type Manager  

Opens the Type Manager dialog for creating section types for concrete 

component design and generic section modeling.  Use this tool to create 

column design sections with reinforcement prior to Code Check/Design of 

columns.   

4.15.2 Settings Panel 

 

 

Set Path for S-Concrete  

Sets the file path to the location of the S-Concrete application executable 

for design integration with ADAPT-Builder.  

Column Design Options  

Opens the Design Options dialog for selection of design load 

combinations, column design parameter and design constraints.   

4.15.3 Live Load Reduction Ribbon 
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Live Load Reduction  

Opens the Live Load Reduction Factors table for reduction method, area 

and factors, application settings.  These reduction factors apply only to 

reduction of loads tagged as Reducible from Loading-Load Case 

Library. The reduction factor calculation is dependent on creation of 

tributary regions from Loading-Tributary Load Manager.  Load 

Reduction Factors are applied only in two ways: 

o Column Design 

Go to Column Design-Column Design Options.  If set to YES 

the reduced loads will be applied for column design.  

o Analysis of Single-Level 

If a Multi-Level analysis has been performed, reactions can be re-

applied in Single-Level mode with inclusion of load takedown (Fz 

reactions).  Go to Analysis-Analyze Structure and use the option 

to Apply Live Load Reduction.    

4.15.4 Design Panel 

 

 

Code Check  

Performs a column code check for the defined section type and 

reinforcement assigned to the selected columns or design groups. The 

code check is performed for the defined Design Code set in Column 

Design – Column Design Options. Right-click on a column to view the 

design summary or use Results – Result Display Settings – Column – 

Individual Column Design Results.   

Design Columns  

Performs the design for the selected column design groups per the set 

design code and presents the proposed design in a summary for 

acceptance. If the design is accepted and updated, the Section Type 

Manager will be updated to reflect the change. Right-click on a column to 

view the design summary or use Results – Result Display Settings – 

Column – Design Group Results.    
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Open in S-Concrete  

Opens the selected column in S-Concrete for code check or design.   

Column Design Summary  

Opens the Design Summary window to display the current and proposed 

results for designed column groups.  

Result Display Settings  

Opens/Closes the Result Display Settings panel for load selection and 

settings of graphical analysis and design results.   

4.15.5 Reports Panel 

 

 

 

Column Reporting Expanded 

 

 

 

o Column Reactions – Tabular 

Produces column reactions at top and bottom column locations for 

solved load combinations.   
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o Column Reactions - Graphical  

Opens the Column Reactions dialog to produce graphical column 

reactions.  

o Column Design  

Opens a .XLS file containing column design information.   

o Column Tributary  

Opens a .XLS file containing tributary area, load and FEM reaction 

information for solved load cases.    

o Tributary Load Check  

 Opens a .XLS file containing tributary load validation check for 

equilibrium.  

o Column Design Summary  

Opens the Design Summary window to enable selection of View 

Report for the HTML summary page for design groups. 

4.15.6 Labels Panel 

 

  

Reset Non-User Defined Labels  

Resets the labels of all components in the model back to a counter of 1 

with the “Label prefix” for each component type and for components 

whose label has not been altered by the user.  

Reset All  

Resets the labels of all components in the model back to a counter of 1 

with the “Label” prefix for each component type.  

Reset Column/Wall Stack  

Opens the dialog window for Automatic Labeling of Stacked Supports 

and resets the labels of all continuously vertical column and/or walls. 

Applies the label at the bottom-most component in the stack to all other 

columns or walls in the stack.  
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4.15.7 Visibility Panel 

 

 

Columns Only  

Isolates the columns for on/off display. 
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4.16 WALL DESIGN RIBBON 

 

4.16.1 Settings Panel 

 

 

Define Pier Labels  

Creates pier labels for assignment to walls or wall groups.     

4.16.2 Sections Panel 

 

 

Generate Wall Sections  

Creates wall design sections at the top and bottom of each wall assigned as 

a pier. Sections are created for each wall leg associated to a pier when the 

angle with adjacent walls is more than 10deg.  

Update Wall Sections  

Updates existing wall sections when material properties or wall length or 

thickness have changed.  

4.16.3 Design Panel 
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Wall Design Manager  

Opens the Wall Design Manager for creating wall section reinforcement, 

parameters, selection of load combinations, processing code checks or 

design and reporting interaction and wall intersection diagrams.  

Wall Design Manager Expanded 

 

 
 

o Locate S-Concrete  

Sets the file path to the location of the S-Concrete application 

executable for design integration with ADAPT-Builder.  

Wall Design Summary  

Opens the HTML summary page for the selected wall design sections.  

Result Display Settings  

Opens/Closes the Result Display Settings panel for load selection and 

settings of graphical analysis and design results.   

4.16.4 Reports 
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Wall Reporting Expanded 

 

 
 

o Wall Reactions - Tabular  

Produces wall reactions at top and bottom column locations for 

solved load combinations.   

o Wall Reactions - Graphical  

Opens the Wall Reactions dialog to produce graphical wall 

reactions.  

o Pier Reactions  

Opens a .XLS file containing pier geometry, properties and 

reactions for solved load combinations.    

o Wall Design Sections  

Opens a .XLS file containing wall design section reinforcement, 

geometry, and design loads and utilization checks.   

o Wall Design Summary  

Creates a combined PDF summary report for the selected wall 

design sections.  

o Wall Intersection Summary  

Creates a combined PDF summary report for joint intersection 

details of designed wall sections.   
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4.16.5 Labels Panel 

 

  

Reset Non-User Defined Labels  

Resets the labels of all components in the model back to a counter of 1 

with the “Label prefix” for each component type and for components 

whose label has not been altered by the user.  

Reset All  

Resets the labels of all components in the model back to a counter of 1 

with the “Label” prefix for each component type.  

Reset Column/Wall Stack  

Opens the dialog window for Automatic Labeling of Stacked Supports 

and resets the labels of all continuously vertical column and/or walls. 

Applies the label at the bottom-most component in the stack to all other 

columns or walls in the stack.  

4.16.6 Visibility Panel 

 

 

Walls Only  

Isolates the walls for on/off display. 
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4.17 REPORTS RIBBON 

 

4.17.1 Print Panel 

 

 

Print  

Opens printer selection and settings and prints active screen. 

4.17.2 Compiled Reports 

 

 

Open Report Compiler  

Opens the Report Generation Manager for selecting tabular and 

graphical reports and screenshots to be generated as a compiled report.  

After making selections, use FILE-Generate Compiled Report.   

Take Report Screenshot  

Saves the graphical screen with user-defined name to the Report 

Generation Manager. Use this option to produce custom images for a 

compiled report.  

Settings  

Opens settings windows for various graphical reports that require user 

input before being created. For compiled reports the user can use the 

settings icon to set the inputs for these report pages prior to creating the 

compiled report.  
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4.17.3 Single Default Reports Panel 

 

 

4.17.3.1 General  

 

Report/Project Title Settings  

Set the General and Specific title and information lines.  

Report Cover  

Generates a .RTF file with report title settings.   

Material and Desgin Criteria  

Gerates a .RTF tabular report with material and design criteria 

settings for the model.  

Quantity and Cost   

Generates a .RTF tabular report with material quantity and cost 

for the model components for the current mode (Single- or 

Multi-Level).   
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4.17.3.2 Structural  

 

 

Slab Regions Detailed Report   

Generates a .RTF file with slab vertices coordinates for slabs in 

the current  mode.     

Slab Regions Summary Report  

Generates a .RTF file with slab material, area and volume for 

slabs in the current mode. 

Openings Detailed Report  

Generates a .RTF file with opening vertices coordinates for  

openings in the current mode.    

Beams Detailed Report  

Generates a .RTF file with beam material, geometry, volume 

and length for beams in the current mode.     

Columns Detailed Report  

Generates a .RTF file with column material, geometry, volume 

and length for columns in the current mode.     
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Drop Caps/Panels Detailed Report  

Generates a .RTF file with drop cap/panel material and 

geometry for drop caps/panels in the current mode.     

Walls Detailed Report  

Generates a .RTF file with wall material, geometry, volume 

and length for walls in the current mode.     

Point Springs Detailed Report  

Generates a .RTF file with spring translational and rotational 

subgrade modulus values for  and location coordinates for 

point springs in the current mode.  

Point Springs Summary Report  

Generates a .RTF file with spring subgrade modulus for Kzz, 

location coordinates and spring type (C or T) for point springs 

in the current mode. 

Area Springs Detailed Report  

Generates a .RTF file with spring subgrade modulus for Kzz 

and  location coordinates for area springs in the current mode. 

Releases and Restraints Detailed Report  

Generates a .RTF file with point and line support coordinates 

and translational and rotational fixity  in the current mode.  

Plan Geometry  

Displays a plan view of all modeled components and 

dimensions for the current level.    
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4.17.3.3 Loads  

 

Load Cases and Combinations  

Generates a .RTF file with load cases and combinations 

defined in the model.  

Skip Pattern  

Generates a .RTF file listing pattern loads with included sub-

regions, skip factors and load reduction factors.  

Applied Loads  

Generates a .RTF file with coordinates, load magnitudes and 

parameters (Seismic) for all applied loads in the model.   

Dead Load  

Displays a plan view of all modeled Dead loads and magnitude 

for the current level.    

Live Load  

Displays a plan view of all modeled Live loads and magnitude 

for the current level.    

User Defined Load Cases  

Displays a plan view of all modeled user-defined General load 

case loads and magnitude for the current level.  
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Column Tributary  

Opens a .XLS file containing tributary area, load and FEM 

reaction information for solved load cases.    

Tributary Load Check  

Opens a .XLS file containing tributary load validation check 

for equilibrium.  

4.17.3.4 Tendon  

 

 

Tendon Report 

Generates a .RTF file with individual tendons geometry, 

system type and friction parameters for tendons in the current 

mode.  

Tendon Group Report  

Generates a .RTF file with tendon group geometry, system type 

and friction parameters for the model.   

Tendon Elongation, Individual Report 

Generates a .RTF file with individual tendons jacking force, 

seating distance, and elongation for tendons in the current 

mode. Requires use of Calculated Force option for stressing in 

the tendon properties.   
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Tendon Elongation, Group Report  

Generates a .RTF file with tendon group jacking force, seating 

distance, and elongation for the model.  Requires use of 

Calculated Force option for stressing in the tendon properties.   

Tendon Totals  

Generates a .RTF file with tendon totals for strand and duct 

length, number of strands, weight and stressing ends for 

tendons in the current mode.  

Felt 3D Long-Term Loss 

Produces combined prestress loss and elongation report in PDF 

format for the total number of strands assigned to the tendon. 

Felt 3D LTL - Single Strand 

Option to reports losses as a function of a single strand when 

the number of strands designated exceeds 1.   

Tendon Plan  

Opens the Tendon Report dialog for display selection and 

creates a plan view of tendons for the current level.    

4.17.3.5 Rebar  

 

 

Rebar List  

Generates a .RTF file with size, quantity, and length for 

calculated and base reinforcement in the current mode.    



Chapter 4 TOOLBARS AND DIALOG WINDOWS  

122 

Rebar Legend  

Generates a .RTF file for a rebar legend with like 

reinforcement for size, length and placement (T or B) in the 

current mode.   

Rebar Totals  

Generates a .RTF file with total size, quantity, length and cost 

for all longitudinal reinforcement in the current mode.     

Design Section Rebar Tabular Report  

Generates a .RTF tabular report for required flexure and shear 

reinforcement at design sections in the current mode.   

Punching Shear Reinforcement  

Generates a .RTF file with schedule for stud rails or links at 

column locations requiring shear reinforcement.  

Rebar Plan 

Opens the Rebar dialog for display selection and creates a plan 

view of reinforcement for the current level.    

4.17.3.6 Punching Shear  

 

Stress Check Parameters  

Generates a .RTF file with a summary of column punching 

shear parameters for the critical section producing the 

controlling stress ratio.   

Stress Check Results 

Generates a .RTF file with a summary of column punching 

shear results for the critical section producing the controlling 

stress ratio.   
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Punching Shear Reinforcement  

Generates a .RTF file with schedule for stud rails or links at 

column locations requiring shear reinforcement.  

Punching Shear Report (XLS) 

Generates a .XLS file including shear calculation results for 

each critical layer checked along with schedules for stud rails 

or links at column locations requiring shear reinforcement.  

4.17.3.7 Column  

 

 

Column Reactions - Tabular  

Produces column reactions at top and bottom column locations 

for solved load combinations.   

Column Reactions – Graphical 

Opens the Column Reactions dialog to produce graphical 

column reactions.  

Column Design  

Opens a .XLS file containing column design information.   

Column Tributary  

Opens a .XLS file containing tributary area, load and FEM 

reaction information for solved load cases.    
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Tributary Load Check  

Opens a .XLS file containing tributary load validation check 

for equilibrium.  

Column Design Summary  

Opens the Design Summary window to enable selection of 

View Report for the HTML summary page for design groups.  

4.17.3.8 Wall  

 

Wall Reactions - Tabular  

Produces wall reactions at top and bottom column locations for 

solved load combinations.   

Column Reactions - Graphical  

Opens the Wall Reactions dialog to produce graphical wall 

reactions.  

Pier Reactions  

Opens a .XLS file containing pier geometry, properties and 

reactions for solved load combinations.    

Wall Design Sections 

Opens a .XLS file containing wall design section 

reinforcement, geometry, and design loads and utilization 

checks.   
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Wall Design Summary  

Creates a combined PDF summary report for the selected wall 

design sections.  

Wall Intersection Summary  

Creates a combined PDF summary report for joint intersection 

details of designed wall sections.   

4.17.4 Analysis Reports Panel 

 

 

4.17.4.1 Design Section/Strip  

 

 

Design Section Forces Tabular Report 

Generates a .RTF file reporting design section actions and 

stresses (when tendons included)  at the current level.    
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Design Section Rebar Tabular Report  

Generates a .RTF file for required flexure and shear section 

reinforcement at the current level.    

Design Section Moment Capacities Tabular Report  

Generates a .RTF file for positive and negative capacities for 

design sections in the current level.   

Design Section Dimensions Tabular Report 

Generates a .RTF file for design section dimensions for 

sections at the current level.  

Design Section Geometry Tabular Report  

Generates a .RTF file for geometric properties for sections at 

the current level.  

Support Lines X-Direction Plan  

Displays X-direction support lines and labels in plan view.      

Support Lines Y-Direction Plan  

Displays Y-direction support lines and labels in plan view.      

Design Strips X-Direction Plan  

Displays X-direction design strips and labels in plan view.      

Design Strips Y-Direction Plan  

Displays Y-direction design strips and labels in plan view.      

Design Check X-Direction Plan  

Displays X-direction design strips graphical stress check in 

plan view.      

Design Check Y-Direction Plan  

Displays Y-direction design strips graphical stress check in 

plan view.      
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4.17.4.2 Analysis Data  

 

 

Equilibrium Check  

Generates a .RTF file with gravity and lateral load equilbrium 

checks for solved applied loads and reactions.  

Solution Statistics  

Generates a .RTF file reporting total number of nodes, 

elements and solved load cases and combinations for the 

current analysis.    

Analysis Nodes  

Generates a .RTF file for analysis nodes and location 

coordinates for the current analysis.   

Analysis Elements  

Generates a .RTF file for shell and frame elements with 

connected analysis nodes for the current analysis.  

Analysis Mesh Plan  

Displays a plan view of the current analysis finite element 

mesh.     

Drift Report 

Generates a .XLS file after selecting Report Options for 

combinations, Allowable Values and directions considered.  

The drift report contains column coordinate and elevation data, 
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displacement and drift data for columns and story data for 

average drift at each level. Plot data is reported for graph 

production in Excel.  . 

4.17.4.3 Reactions  

 

Point Support Reactions  

Generates a .RTF file with point support label and reactions for 

Fxx, Fyy, Fzz, Mxx, Myy, and Mzz.  

Line Support Reactions  

Generates a .RTF file with point support label and reactions for 

Fxx, Fyy, Fzz, Mxx, Myy, and Mzz. 

Point Spring Reactions  

Generates a .RTF file with point support label and reactions for 

Fxx, Fyy, Fzz, Mxx, Myy, and Mzz. 

Line Spring Reactions  

Generates a .RTF file with point support label and reactions for 

Fxx, Fyy, Fzz, Mxx, Myy, and Mzz. 



 TOOLBARS AND DIALOG WINDOWS Chapter 4 

129 

4.17.4.4 Export DWG Panel 

 

 

 

Export DWG/DXF  

Opens the dialog for selecting the AutoCAD version and 

tendon type (linear or spline) for export of the current view as a 

.DWG or .DXF file.   
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5.1 OVERVIEW 

This chapter describes in detail how to generate a structural model. You will use 

the structural model for your analysis and design, either via ADAPT-PT or using 

the ADAPT-Floor Pro option. Your structural model will be the same, regardless 

of which method you use. The creation of a structural model is your first step in 

using the BUILDER platform for your design and drafting, regardless of whether 

the structure is conventionally reinforced or prestressed. The previous chapters 

described the environment of the program and the general-purpose tools of 

drafting, editing and viewing. The focus of this chapter is on components that 

form your structure, such as columns and slabs. These are called Structural 

Components. 

In this manual we will go through the process of modeling a single-level model. 

Please refer to the program tutorials for the modeling and design of multi-level 

models. The structural model will be a faithful three-dimensional representation 

of the shape of the floor system you plan to design, along with one story of 

supporting structure (walls and columns) below it and, if any, one story of walls 

and columns above it. It will be a single-level floor system. However, it will 

include all the details, such as openings, steps on the slab, beams, drop caps and 

drop panels. The following figure shows a representation of a structural model 

displayed in wire frame format. 

 

FIGURE 5.1-1 THREE-DIMENSIONAL VIEW OF STRUCTURAL MODEL 

You can view the structural model in solid and other formats too. This is 

explained in the sections dealing with the viewers of the program. 

In addition to the geometry, you also will define boundary conditions for the 

model. That is to say, the manner in which the structure is supported, or the way 
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parts of the structure are connected.  For example, you may wish the connection 

between a slab region and its supporting column to be hinged. This is described in 

the section on Release/Restraints.  

Presence of loads, such as self-weight, live load or other loads also is considered 

to be part of the structural model and will be discussed in this chapter. How the 

loads should be factored and combined to meet the requirements of various 

building codes, however, this will be covered later in the sections dealing with 

analysis and design options. Similarly, selection of design codes and design 

criteria are handled in the chapters covering analysis and design. 

5.2 STRUCTURAL MODEL PARTS  

5.2.1 Structural Components 

The building structure you model consists of entities called Structural 

Components. You assemble the components to form a true representation 

of the floor system and its supporting structure. 

The primary Structural Components of the current version of the program 

are: 

Slab regions 

Columns 

Openings 

Beams 

Drop cap/drop panel 

Ramps (see the ADAPT-Builder 2019 New Features Supplement 

manual) 

Springs (point spring, line spring or area springs) 

Supports (point support or line support) 

If you use ADAPT-Floor Pro, with the PT Module active, an additional 

component is available: 

Prestressing tendons 

If you use ADAPT-MAT for the mat foundation, you have: 
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Soil area support 

Further, the Rebar Module of the program includes: 

Bar reinforcement (rebar) 

5.2.2 Common Properties of Structural Components 

Each Structural Component has properties specific to itself, such as 

material and location. The properties of each Structural Component are 

listed in their component’s property box. Some of these property items, 

such as specification of material, are common among all components. The 

following describes the most common properties.  

There are four ways you can open the property box of an entity. These are: 

Double-click on it. 

Select the entity, then click on the Item Properties  icon on the 

Bottom Quick Access Toolbar. 

Select the entity, go to Modify→Properties and click on the Item 

Properties  icon. 

Place the cursor over it, right-click and select Properties from the 

list that opens. 

The property box of a slab region (Fig. 5.2-1) is used as a sample to 

describe the common properties. 

GENERAL TAB (Fig.5.2-1(a)): 

#. This field displays the number of the entity. Modeler automatically 

assigns an ascending number (1, 2, 3…) to this field each time an entity of 

the same type, such as a column, is created. If you delete an entity, the 

program automatically re-numbers the entities of that group, before saving 

the data. The last number gives the total count of entities of any given 

group used in your model. You cannot change the information displayed 

in this field. 

Label. In this field, the program assigns a name to each entity. For 

example, for the third column you generate, it will assign “Column_3.” 

The important difference between this field and the one above is that in 

this field you can enter a name that you assign to the entity, such as 



Chapter 5 STRUCTURAL MODELING TOOLS  

136 

“Rose.” In its reports, the program will list the name you have assigned to 

the entity along with the number it selected in the previous field. 

 

(a)  General Tab 

 

(b) Location Tab 
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(c)  Stiffness Modifiers 

 

(d)  Properties Tab 

 
FIGURE 5.2-1 SAMPLE PROPERTY BOX 

Material. This field identifies the material selected for the structural 

component. You can change the material of the structural model by 

selecting a different one listed in the combo box. If the material you intend 

to use is not listed, you must go to the Material pull-down menu and first 
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define it. Once you do so, the new material will appear on the list of the 

combo box for you to select. 

Group.  Each entity, whether a Structural Component or an arc, is placed 

in a group. It was described in earlier chapters how to select specific 

groups for display or other operations. Initially, the program places every 

entity in its default group “Group 1.”  You can move the entity created 

into a different group by selecting the group of your choice from the list in 

the combo box. If you want to create a new group, you must go to the 

Grouping menu item in the Settings pull-down menu. 

Other Properties. Depending on the type of the entity at hand, there will 

be other properties, such as dimensions, that will be listed for view and 

editing. 

LOCATION TAB (Fig.5.2-1(b)): 

Offset. The value given as offset defines the location of the entity with 

respect to the reference plane to which it is associated. For example, an 

offset for slab will describe the distance of the top of slab to the current 

plane. An offset for the top of an upper column gives the distance of the 

column top end from the top reference line. 

Coordinates. The coordinates of the vertices of each entity is listed in a 

table. You can select each vertex and edit its coordinates. This option 

enables you to place an entity at an exact location. 

STIFFNESS MODIFIERS TAB (Fig.5.2-1(c)): 

A1 direction. Angle between local element axes 1 and 2 and the global X 

and Y axes.  Default is zero.  This applies only to slab regions.  

 Modifiers table.  Shows the default (uncracked) usage case and any user-

defined usage cases with applicable modifiers (1.0 or less) for bending, 

shear and axial.   

Edit Usage. Opens the Combination Usages dialog to define a new usage 

case and stiffness modifiers.   

PROPERTIES TAB (Fig.5.2-1(d)): 
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Layer. This field shows where the graphical display information of the 

entity is saved. You can change the layer to another one from the list in 

combo box. 

Line Thickness.  This field is used to edit the width of the lines used to 

display the entity. It applied to display on the screen and in printed 

hardcopies.  

Color.  This field is used to edit the color of the object on the screen. 

Filling. This field is used to choose and display a fill pattern for the 

display of an entity, if it covers an area such as a slab. 

5.3 LEVEL ASSIGNMENTS 

When modeling a single level, you model one floor level along with the supports 

immediately below and above it. You will be using three horizontal planes to 

describe the structure. The first is the level you have selected to design. It is 

referred to as the current plane. All the features of the floor system, such as the 

position of the slab regions, beams and steps on the slab will be expressed with 

respect to this plane (Fig 5.3-1). The walls and columns below the slab are 

assumed to extend from the current plane to the plane below it (bottom plane). 

Likewise, the walls and columns above the slab extend from the current plane to 

the next plane above (top plane). These are the default length assignments of the 

program. The user can modify the length of a support above or below to a value 

different from the distance between the two respective planes. This will be 

explained along with the modeling of walls and columns. 

 

FIGURE 5.3-1 REFERENCE PLANES (LEVEL ASSIGNMENT) 

 IN ELEVATION 

Note that in Fig. 5.3-1 one of the columns does not extend to the top plane. The 

top of that column is said to have an offset with respect to its natural position (top 
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plane). Similarly, a section of the slab is stepped down below the current plane. 

Again, this slab region is viewed to have an offset with respect to its natural 

(default) position.  

Unless you specify otherwise, the program initially inserts each structural 

component with respect of the reference planes as shown in Fig. 5.3-2. 

 

FIGURE 5.3-2 

You can adjust the program’s initial positioning of the structural components, by 

using the Offset feature of each component (Fig. 5.3-3). This is described later. 
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FIGURE 5.3-3 

Figure 5.3-4 is an illustration of a complex floor system composed of the basic 

Structural Components and the offset features. 
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FIGURE 5.3-4 

The program comes with default values for the distance between the 

current plane and the top and bottom planes. You may need to change this, 

however, to match the details of your project. This is explained next. 

5.4 LEVEL ASSIGNMENT TOOL 

The Level Assignment tool specifies the distance between the top of the typical 

region of the floor slab you are designing to the top of the slab above (top plane) 

and the top of the slab below (bottom plane). When you create a column or wall, 

it will initially assume the distances you specify here, until you change it. 

 Level Assignment. This button is in the Upper-Right Level Toolbar. It 

opens the Reference Plane dialog box (Fig. 5.4-1) in which the distance 
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between the default three reference planes is described by their height 

above a datum level.  

 

FIGURE 5.4-1 REFERENCE PLANE DIALOG WINDOW 

5.5 ORGANIZATION OF THE STRUCTURAL COMPONENTS DATA 

The program stores the graphical information of each of the Structural 

Components in a dedicated default layer. You can view these layers by clicking 

on the layer tool with in the Bottom Quick Access toolbar of the screen and 

selecting the layer of your choice for viewing. 

5.6 MODELING OPTIONS 

There are two principal options for modeling real-life projects. One is to start with 

an available architect’s drawing (DWG or DXF file). The other is to draft the 

model entirely within the environment of the BUILDER platform, using the 

Modeler’s drafting capability. In the first case, you may need to use some of the 

Modeler’s drafting capability along with the information obtained from a 

DWG/DXF file. 

When you use a DWG/DXF file to generate a model, most of your work will be in 

the transformation or conversion of the drawing items into Structural 

Components. You are likely to start with the Transform panel of the Model 

ribbon. On the other hand, when you plan to draft your model from scratch, you 

will use the Add Structural Components panel of the Model ribbon.  



Chapter 5 STRUCTURAL MODELING TOOLS  

144 

5.6.1 Transform Panel 

 

You will use these tools if you start with a DWG or DXF file, and plan to 

convert the items shown on the drawing to Structural Components for 

your model. In other words, if you are not importing a drawing for 

conversion to your model, you are not likely to use the tools on this panel. 

You will use the Add Structural Components panel of the Model ribbon. 

Once you import a DWG or DXF drawing, your first choice is to 

transform the items on the imported drawing directly to structural model. 

The items shown on the imported drawing are simply lines (graphics). The 

process of conversion is to (1) pick an item on the drawing, such as a 

column, and (2) click on the associated structural component tool 

(Transform to Column), in order to convert it to a structural component.  

 Transform Polygon Only items that are in form of a closed 

polygon can be picked and converted directly into structural 

components. Not every column or opening in the imported 

structural drawing is drawn as a closed polygon. 

This button is used to transform groups of lines that are drawn 

separately, but intersect into a polygon.  Click on the tool. The 

program searches the drawing and creates polygons for the 

instances where conversion of intersecting lines into polygons is 

practical. The program retains the original items on the drawing, 

but writes the polygons created in a new layer called 

“Polygons_from_line.” 

 Transform Slab Region. This button is used to transform a 

polygon (closed polyline) to a slab region. The tool operates in the 

same manner as the Transform Column  tool, which is described 

in greater detail below. The transformed slab region is always 

located at the Active Reference Plane. 

 Transform Column. This tool is used to transform a rectangle 

(polygon) or circle to a column.   
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To transform a (polygon) rectangle into a column do the following: 

• Select one or more rectangles that are made up of 

polygons. 

• Click on the Transform Column  tool. All selected 

entities will be transformed into columns with the same 

dimensions as the rectangle or circle.   

The default of the program places the transformed columns below 

the slab. If they are intended to be placed above the slab or both 

below and above, you must make the correction either through the 

property box of the column, or by way of using the copy/move 

commands. The use of the property box is described in the section 

on “Add Structural Components Panel.” 

 Transform Wall. This button is used to transform a rectangle 

(closed polyline) into a wall.  The tool operates in the same manner 

as the Transform Column  tool. 

 Transform into Several Walls. When a polygon represents two or 

more intersecting walls, this button is used to transform it into 

several individual walls, each having a rectangular cross-section. 

In the analysis, however, the program treats the walls integrated 

into one along their common vertical joints.  The tool operates in 

the same manner as the Transform Column  tool. 

 Transform Drop Cap/Panel. This button is used to transform a 

rectangle (closed polyline) into a drop cap.  This tool operates in 

the same manner as the Transform Column  tool.   

 Transform Beam. This button is used to transform a polygon 

(closed polyline) into a beam. The tool operates in the same 

manner as the Transform Column  tool.  

 Transform Opening. This button is used to transform a polygon 

(closed polyline) into an opening. The tool operates in the same 

manner as the Transform Column  tool.   
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5.6.2 Add Structural Components Panel 

 

The primary application of this panel is to create a structural model from 

scratch – as opposed to using an imported DWG/ DXF file.  In addition, it 

works as a supplement to the Transformation tool described in the 

preceding, since not all Structural Components can be transformed directly 

from an imported file. You may have to create some of them manually, 

using the tools of this panel.  

For a major real-life structural model, you are likely to start by setting out 

some gridlines, and/or use a grid on the background to help you in your 

drafting. For this purpose, you use the Gridline panel of the Model ribbon, 

described earlier in this manual. 

 Create Slab Region. This tool creates a new slab region with the 

corresponding properties input in the dialog box shown in Fig.5.2-

1. To create a slab region, use the following procedure: 

• Click on the Create Slab Region  icon. The dialog 

box shown in Fig. 5.2-1 will open1.   

• Edit the input fields as required (each input field is 

described below).  These values will be used in the 

future, until they are changed again2. 

• Draw the outline of the slab region.  Click the mouse at 

each point required3. 

• After the last point has been selected, Press C to close 

the area. 

 
1  The property dialog box window will automatically open if you selected option “Open Items Property 

Dialog Box Automatically” in the Home→Settings→General Settings menu, item General Settings (Fig. 

5.2-1) 
2  To have the parameters, such as thickness, material and offset, of the slab region you have created to be 

used for the subsequent slabs you create, you should use the option of “Use Last Properties as Default.” 

This option can be turned on from Home→Settings→General Settings. 
3 You are likely to make mistakes as you trace a slab boundary. During modeling of a slab region the user 

can use CTRL-Z to undo entered points of a slab region. 
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To edit the properties of an existing slab region, open its property 

box and edit as described earlier.  If you want to change the shape 

of a slab region on plan graphically, do the following: 

• To change the location of an entire slab region, make 

sure the Move Selection  tool is highlighted, then 

just drag the slab region by a vertex to its new location. 

The Move Selection tool is located at Home→Selection 

Mode. 

• If you would like to change the location of just one 

vertex, make sure the Move Selected Point  tool is 

highlighted, then just drag the vertex to its new 

location. 

• If you would like to remove a vertex, use Remove Point 

 tool of the Modify ribbon Points panel. 

Alternatively, you can right-click on the slab region and 

choose Remove Vertexes from the slab’s right-click 

menu. 

• If you would like to add a vertex, use Insert Point  

tool of the Modify ribbon Points panel. Alternatively, 

you can right-click on the slab region and choose Insert 

Vertexes from the slab’s right-click menu. 

 Create Column. This tool creates a new Column with the 

properties input in the corresponding dialog box (Fig.5.6-1). To 

create a Column, use the following procedure: 

• Click on the Create Column tool.  The dialog box 

shown below will open. 

• Edit the input fields on each tab as required.  These 

values will be used in the future, until they are changed 

again. 

• Click the mouse at the column location (you may do 

this in conjunction with snapping tools). 
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FIGURE 5.6-1 COLUMN PROPERTY BOX 

The properties specific to a column are as follows: 

A: This field is used to input dimension “A” of a rectangular or 

square column, and it is also used to input the diameter of circular 

columns.  For a rectangular column, dimension “A” is the length of 

the side along X-axis, if no angle is specified (Ang field, See 

below). 

B: This field is used to input dimension “B” of a rectangular 

column.  Dimension B is the side along the Y-axis if no angle is 

specified. 

Ang: This field is used to input the angular orientation of the 

column on the XY-plane. The orientation is expressed with the 
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counterclockwise angle from the positive direction of X-axis to 

side “A” of the column.  

There are other properties listed in the Column property box that 

relate to the analysis and design features of the program. These are 

discussed either in the Strip Modeling or Finite Element modeling 

sections of the manual. 

 Create Wall. This tool creates a new wall with the properties input 

in the corresponding dialog. To create a new wall, do the 

following: 

• Click on the Create Wall  tool.  The wall’s property 

box opens (if this is the option you have selected in the 

General Settings tool).  

• Edit the input fields on each tab as required. These 

values will be used in the future, until they are changed 

again. 

• Click the mouse at one endpoint of the wall and then 

click at the other end. 

 Create Beam. This tool creates a new beam with dimensions and 

properties that are reflected in its property box. To create a new 

beam, do the following: 

• Click on the Create Beam  tool.   

• Draw the beam.  Click the mouse at one endpoint of the 

beam and then click at the other end. You may have to 

use the snap tools, if you want to connect the beam to 

other structural components.  

Offset. This field is used to input a vertical offset to the beam from 

the reference plane. A value of “0” places the top of the beam at 

the level of the reference plane. A positive offset moves the beam 

down and a negative offset moves the beam up. Fig. 5.6-2 

illustrates two options for inputting the T-beam cross-section.  

Both options shown are equivalent and will produce the same input 

data for ADAPT-PT. Option 2 uses a 5-inch offset. Option 1 will 

result in a larger local stiffness, due to the overlap of slab and 

beam stems. Both options, however, will give the same stress and 

same reinforcement for the same design values (moments and 

shears). 
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Beams may be drawn alone or in conjunction with a topping slab 

to create a T-section.  Beams and slabs are drawn separately in 

modeling the structure.  

 

FIGURE 5.6-2 

 Create Opening. This tool creates a new opening. Click on the 

tool and follow the instructions on the screen. 

 Create Drop Cap/Panel. This tool creates a new drop cap or drop 

panel. Click on the Drop Cap/Panel tool and insert it on a slab 

region. If you want it centered on a column, use the End Snap tool. 

Change the default orientation and dimensions of the drop created 

by opening its property box. 

Drop caps/panels generated using this tool will be rectangular on 

plan, but do not necessarily need to be oriented along the X and Y 

axes. You can rotate the drops using their property boxes. 
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If you have a drop with an irregular shape, you can use the slab 

region tool. With the slab region tool, draw the cap on plan and 

specify its offset and depth to match that of the drop. A newly 

drawn slab region will override the properties (including thickness) 

of the slab region over which it has been drawn. The new slab 

region around a column will act as a drop cap/panel.  

 Create Ramp. This tool creates a new ramp. Click on the Ramp 

tool and insert it on a slab region or within an opening. Change the 

thickness of the ramp created by opening its property box. 

5.6.3 Model→Visibility Panel  

 

This toolbar contains tools that toggle the visibility of the entity they 

display. The following is the list.  

 Display Slab Region  

 Display Wall  

 Display Column 

 Display Drop Cap 

 Display Beam  

 Display Opening 

 Display Ramp 

 Display Gridline 

 Display Point Support 
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 Display Line Support 

 Display Point Spring 

 Display Line Spring 

 Display Soil Support (MAT)/Area Spring (Floor Pro) 

 Display Point Displacement (SOG Only) 

 Display Line Displacement (SOG Only) 

Support lines, splitters and point supports will be discussed later in the 

section on Strip Modeling. 

5.6.4 Loads 

You can apply an essentially unlimited number of loads on the structure. 

The loads can be applied at arbitrary locations, regardless of the method 

and details of the analysis that would follow. The types of load that you 

can specify are: 

Point Load (concentrated or moment) 

Line Load (linearly varying force or moment)  

Patch (area load), uniform intensity or varying in magnitude 

Each load belongs to a load case, such as dead load, superimposed load or 

other load cases that you choose to have. There is essentially no limit on 

the number of load cases. The program comes with a number of pre-

defined load cases. But you can add your own to them. The program’s pre-

defined load cases are: 

Selfweight 

Dead Load 

Live Load 

Prestressing (If you use ADAPT Floor Pro with Prestressing) 

Hyperstatic (If you use ADAPT Floor Pro with Prestressing) 
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Each load has its own property box and can be edited individually. Also, 

you can view each load case on its own. Later, we will discuss how load 

cases can be factored and combined for code check.  

Loads can be applied at any point, line, or area over the slab region. Apart 

from having a shape, such as point load, line load, or patch load, each load 

has a magnitude and belongs to a load case. Loads that when projected 

along the vertical axis do not fall on a slab beam or wall will be 

disregarded by the program. For example, if you place a uniform load over 

an area that contains an opening, or slab cutouts, the program disregards 

the portion of the load that falls on the opening, or falls outside the 

boundary of a slab region. 

Loads can overlap. In other words, you can specify two or more loads that 

in whole, or part, cover the same region. Where there is overlap, the 

program adds the contribution of each to obtain a total load. Negative 

loads can be used to subtract load from the region as well. 

5.6.4.1 Load Case Definition 

If you want to have one or more load cases in addition to those 

already defined by the program and listed above, do the 

following: 

From the Loading→Load Case/Combo panel, select the Load 

Case  icon. The dialog window shown in Fig. 5.6-3 will 

display. The Load Case Library is made up of three parts. The 

General Load (Gravity/Lateral) section deals with gravity and 

all other loads applied on the current slab. The Building Load 

section deals with lateral loads, such as wind and earthquake 

applied through the Wind Load and Seismic Load wizards in a 

multi-story analysis. The Lateral Load Solution Sets part will 

be displayed only if the user checks the box at the top of the 

Load Case window titled Lateral Load Solution Sets includes 

the lateral module4.  

The load cases self-weight, prestressing and hyperstatic are not 

listed in the library displayed, since these are generated 

automatically by the program. You cannot edit them. For 

example, the self-weight is automatically calculated from the 

volume of the structural components and their unit weight. 

 
4  The Lateral Load Solution Sets option of the program is described in the manual “Integration with 

Multistory Programs.” Loads assigned to this option will be treated differently.  
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Likewise, prestressing, if available, is automatically calculated 

from the parameters of tendon profiles and the stressing of 

tendons.  

To create a new load case, click on the Add button. A new load 

case will appear on the list. Click on it if you want to change its 

name (label).   

 

FIGURE 5.6-3 LOAD CASE LIBRARY 

5.6.4.2 General Loading Panel   
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 Add Point Load. This tool inserts a new point load or 

moment with the properties shown in Fig. 5.6-4. To create 

a point load, do the following. 

Click on the Add Point Load  tool.   

• Insert the point load.  

• Open the property box of the point load (if it did not 

open prior to its insertion) and edit the input fields 

on each tab as required.  

 

FIGURE 5.6-4 POINT LOAD DIALOG BOX 

Each point load can be specified with the following load 

components: 

Forces:  Fx, Fy, Fz 

Moments: Mxx, Myy 

The default point of application of a point load is on the reference 

plane. By changing its offset in the property box, you can move the 

point load in the vertical direction too. This becomes important to 
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note when you deal with forces Fx and Fy. A force in the 

horizontal direction applied at the reference plane will have a 

moment about the slab that does not have its centroid on the 

reference line. The program automatically recognizes these 

conditions and accounts for them in its computations.  

 Add Line Load. This tool creates a new line load with the 

properties shown in Fig. 5.6-5. Line loads can consist of a constant 

or variable force along the length of the line with or without 

constant or variable moments Mxx and Myy along the same line. 

The moments are specified about the global axis.  

To create a line load, do the following: 

• Click on the Add Line Load  tool.   

• To draw the line load just click at the two endpoints of 

the load. The load may be drawn outside the slab or 

over openings.  The program automatically recognizes 

this condition and ignores those portions that do not fall 

on a slab region. 

• Edit the input fields on each tab as required.  

 

FIGURE 5.6-5 LINE LOAD DIALOG BOX 
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 Add Patch Load. This tool creates a new patch load. A patch load 

covers an area within a boundary drawn or selected by you.  If the 

area covered by the boundary you draw/identify falls in part 

outside a slab region, the program considers only the loads that fall 

on slab regions, beams, and walls. 

A patch load is defined by the area within its boundary and a plane 

that specifies the distribution of load over it. The distribution of the 

load intensity over the patch is defined by the ordinates of three of 

its vertices, identified as vertices1, 2 and 3. You can enter the 

value at these points, and view the distribution of the load on the 

screen. If the vertices selected are not the right ones, use the arrow 

tool to move your selection along the boundary of the patch, until 

you reach the right location ( ). 

You can specify the following load distributions over a patch 

load: 

Forces:  Fx, Fy, Fz 

Moments: Mx, My 

To create a patch load, do the following. 

• Click on the Add Patch Load  tool.   

• Edit the input fields on each tab as required (Fig.5.6-6).  

• Click at the vertex points on the perimeter of the load 

area.  The load may be drawn outside the slab, or over 

slab openings.  The program automatically recognizes 

this condition and ignores those portions that do not fall 

directly on a slab region. 

• After clicking on the last vertex, input C to close the 

input. 

• To edit a patch load, open its property box (shown 

below). 
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FIGURE 5.6-6 PATCH LOAD DIALOG BOX 

 Patch Load Wizard. This tool creates an area load over an 

enclosed region that you select.  To automatically create a set of 

patch loads, do the following. 

• Select a polygon or slab region that you would like to 

apply a patch load over. 

• Click on the Patch Load Wizard  tool.   

• Enter the value and load case. The program will 

automatically generate a patch load over the area 

selected. 

• To edit the load you selected, open the property box of 

the load. 

 Line Load Wizard. This tool automatically creates a set of line 

loads on a line, beam or wall that you select. It also works for a 

load over a polyline. 

To generate a set of line loads on selected line do the following. 

• Select the line or polyline over which you want to 

generate a set of line loads. 

• Click on the Line Load Wizard  tool.   
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• Edit the input fields of the dialog box that opens as 

required.  

• Click on the Create button to create the loads. A line 

load for each load case specified will be generated 

automatically over the lengths of the line(s) chosen. 

 Import Loads. This tool allows the user to import loads to the 

model through the use of an Excel file. 
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6.1 OVERVIEW 

This Chapter describes the tools you will be using for the analysis and design of 

the structural model you have created, regardless of the method of analysis. The 

following tools may be found in the Floor Design and PT/RC Export ribbons. The 

tools that apply to the Equivalent Frame Method of design (EFM) that uses 

ADAPT-RC or ADAPT-PT can be found in the PT/RC Export ribbon, while the 

tools that apply to the Finite Element Method (FEM) of analysis and design that 

uses ADAPT Floor Pro, can be found in the Floor Design ribbon. The application 

of tools within that are similar in both ribbons will be the same in each ribbon.  

Briefly, you identify a region of a floor system as a design strip, determine the 

actions (moments, shears, etc) that are associated with the design strip selected, 

find out whether the actions determined for the design strip can be resisted within 

the requirements of the building code you select (code check), and then calculate 

the reinforcement that must be placed within the design strip. 

Figure 6.1-1(a) shows a floor system and a single design strip. For a complete 

design, you must cover the entire floor plan with several design strips. The 

elements of a design strip generally include:  

• Support Line 

• Supports 

• Tributary 

• Splitter 

The tributary determines the region of consideration. The support line identifies 

the direction along which the reinforcement is calculated and is likely to be 

placed.  Selection of supports, such as walls/columns, and beams, either by you or 

by the program automatically, will result in the appropriate selection of building 

code provisions in the code check part of the design process. 
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(a) 3D Wire Outline View of the Structure 

 

(b) Identification of a Support Line, Tributary and Design Strip 

 
FIGURE 6.1-1 SUPPORT LINE, TRIBUTARY AND DESIGN STRIP 

Design strips are generated automatically by the program. The automatic 

generation follows a number of rules detailed below. Some of the considerations 

are: 

• Width of a Design Strip. The program creates a uniform tributary over 

the entire length of each span with a width equal to the largest width of the 

non-idealized tributary.  This is generally conservative. It can be improved 

if you select a Splitter and break each span into more segments. Splitter is 

a tool that is described later in this Chapter.  

• Separation of Adjacent Design Strips. The separation between two 

adjacent design strips is done by the program automatically, along the line 

that breaks the distance between two adjacent support lines into two equal 

parts. If this automatic separation is not where you want it, you can 

override it by drawing a Splitter along the tributary line of your choice. 

• Modeling of Openings. Openings are not considered in the generation of 

tributaries or design cut. Section cuts ending within an opening will only 

include the portion of the design section that cuts a concrete component, 

the area within the opening will be disregarded for design. Sections 

generated by the program that cut through and opening and into concrete 

on the other side of the opening will be idealized into one monolithic piece 

of concrete. Depending on the size of the opening, using Splitters, you can 

exercise full control of how the region around it should be accounted for 

in load transfer. 

As mentioned earlier, strip modeling tools generally are applicable to both 

ADAPT-PT and Floor Pro. Where a tool is specific to ADAPT-PT it is so 
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identified. By disregarding these, you will be concentrating on the tools that are 

applicable to ADAPT Floor Pro. As a guide, the tools that are specific to ADAPT-

RC/PT are shown with a brown background. Skip these, if you do not intend to 

export your data to ADAPT-RC or ADAPT-PT. These specific tools also will not 

appear on your computer screen if you do not select the PT/RC Strip Mode option 

in the splash window (first screen) that appears when you open the program.  

6.2 STRIP MODELING TOOLS 

         
        Floor Design Ribbon               PT/RC Export Ribbon 

The Create X Support Line, Create Y Support Line, Dynamic Editor (Floor Pro 

Only) and Support Line Wizard (PT/RC Strip Method Only) of these toolbars deal 

specifically with the creation of design strips. The remainder helps you to 

improve or correct your work. 

,  Create X/Y Support Line. You use these tools to create a new support 

line manually. Clicking on the Create X Support Line  will create a 

support line that has been designated in the X-direction. Clicking on the 

Create Y Support Line  will create a support line that has been 

designated in the Y-direction. In most instances the Dynamic Editor or 

Support Line Wizard  will be simpler and faster to use. Generally, it is 

recommended to use the Dynamic Editor or the Support Line Wizard and 

edit the support line they create, if needed. Use of the Support Line 

Wizard is described later in this section. Use of the Dynamic Editor is 

outline in the ADAPT-Builder 2019 New Features Supplement 

Manual. Note that in ADAPT-Builder 20 new features for creating middle 

strips have been added to the support line Dynamic Editor. For more 

information on the new middle strip features please refer to the ADAPT-

Builder 20 New Features Supplement Manual. 

The program no longer requires a support line to end at a slab edge or 

splitter. The support line can end at any arbitrary location and the program 

will use the end point as the end tributary boundary for the design strip. 

The support line can start or terminate at another support line. The use of 

splitters is discussed later in this section. 
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You draw the support line manually using the mouse. Each support line is 

drawn by clicking from slab edge to each support along a chosen line to 

the other slab edge, using the Snapping tools to facilitate correct 

placement. The program uses each support line to define the following 

design parameters: 

The number of spans in the design strip. A span is the support line 

segment between two insertion points.  If an end insertion point 

does not correspond to a support location, then the span defines a 

cantilever.  

 

The lengths of all spans and cantilevers. The length of each 

segment defines the length of each span in the design strip. 

In conjunction with adjacent design strips, the width of the design 

strip in each span is based upon midpoints between two adjacent 

support lines, unless you use splitters to delineate a tributary. 

When generating support lines, it is important to keep in mind that all 

support line insertion points must correspond with one of the following 

points: 

A slab edge, real or apparent: Generally, the first and last insertion 

point should be snapped to the outside edge of the slab (the real 

slab edge).  These points may or may not also correspond to a 

support location.  If not, the end segment defines a cantilever.  

Note that a cantilever may be defined by a very short support line 

segment if the support’s insertion point lies just inside the slab 

edge. 

 

For special situations, you may extend a support line beyond the 

boundary of a slab, if you wish an overhang that is not directly 

along the support line you are creating to be accounted for in your 

design. 

 

Column, wall, beam, or point supports:  Each interior insertion 

point must correspond to the insertion point (end point) of a 

column, wall, beam or point support. If the support line passes over 

a wall or beam, the insertion point must correspond to the 

wall/beam centerline.  If the support line runs along the top of a 

wall or beam, then one insertion point is placed at one end of the 

wall/beam and another insertion point at the other end of the 

wall/beam.  

 

Another support line:  Specifically, for ADAPT-PT modeling, if 

one support line is intended to support an intersecting support line, 
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you will use a point support at the intersection of the two support 

lines, below the support line that is shedding load.2 

To generate a support line: 

Click on the Create X or Y Support Line ( , ) icon.   

 

Set up object snapping tools so the cursor will snap to the desired 

points (endpoints for columns, nearest point for slab edges, nearest 

point for wall center line, end point for wall end).   

 

Draw the support line.  Left click the mouse at each point required. 

After the last point has been inserted, Press C to close the input of 

the support line or press the End key. 

To edit a previously drawn support line: 

Select the desired support line.  

 

To open the dialog box just double-click on the support line or 

right-click and select Properties from the object menu that opens.  

 

Edit the input fields on each tab of the dialog box as required (each 

input field is described below). 

 

Click OK to accept the new input values. 

 

If you would like to change the support line location, make sure 

the Move Selection tool is highlighted, then just drag the support 

line by an insertion point to its new location. 

 

If you would like to change the location of just one insertion point, 

make sure the Move Selected Point tool is highlighted, then just 

drag the insertion point to its new location. 

 

If you would like to remove an insertion point, select the point and 

click on the Delete Point tool.  

 

If you would like to add an insertion point, select the insertion 

point next to the one you plan to insert and click on the Insert 

Point tool. Then just drag the point to its final location. 

 

 
2 To insert support use Create Design Strip Support tool as described later in this Chapter. 



Chapter 6 STRIP MODELING TOOLS   

168 

Specific input controls are described below.   

 

FIGURE 6.2-1 SUPPORT LINE GENERAL TAB 

GENERAL TAB (Fig.6.2-1): 

Direction, X-Direction; Y-Direction. This field is used to select the 

direction of the Support Line (X- or Y-direction).  X and Y refer to the 

orientation of the principal reinforcement in two directions. They do not 

refer to the global axes that use the same symbol. For each support line, 

the direction is determined by the line you draw on plan for that support 

line. This field will be automatically set to X-direction when you use the 

Create X-direction Support Line tool, and Y-direction when you use the 

Create Y-direction Support Line tool. Note: Two support lines with the 

same defined direction cannot intersect/cross over one another. The user 

may end a support line at another support line with the same defined 

direction but the program will give errors if the support line crosses over 

another support line of the same defined direction. 

 

DESIGN TAB (Fig.6.2-2): 

Criteria. This combo box describes the code criteria you wish to be used 

for the design of the design strip selected. Depending on the building code 

you will select later, the program will give priority to the requirements of 

the building code and override the selection made here, should there be a 

conflict. For example, if there is a beam in the model, the program will 

treat it as a beam and will calculate the stirrup requirement, even if it is 

specified otherwise in this field. 
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Tendon Profile (Specific to ADAPT-PT). This field is used to select a 

predefined tendon shape for the support line.  Before the support line is 

drawn, only one profile type may be assigned. After the support line is 

drawn, however, the dialog box may be reopened and a different tendon 

profile assigned to each span of the support line. 

 

FIGURE 6.2-2 DESIGN TAB OF SUPPORT LINE 

Outer Layer/Inner Layer. The rebar cover you specify in the criteria of the 

program is from the surface of concrete to the first layer of primary 

reinforcement. For reinforcement in two directions, one of the layers will 

be the outer layer (near the surface) and the other layer the inner layer 

(nearer to the center of the slab). Here, you specify the position of the 

primary reinforcement for and inner or outer layer. 

DISPLAY TAB, Fig 6.2-3(specific to ADAPT-PT): 

When a design strip is to be analyzed and designed separate from the rest 

of the structure, as is the case in strip methods, its geometry will be 

idealized. Likewise, the loading that falls on the tributary will be 

transferred to the support line of the design strip. The tools of the Display 

Tab enable you to view the idealization done by the program. You will 

have the opportunity to review and edit the program’s idealization before 

exporting the design strip information to ADAPT-PT for analysis and 

design.  

Load region separator. Displays the load separators of the support line.  

Load separators are used to specify how a load is divided among adjacent 

spans.  The initial orientation of a load separator, as calculated by the 

program, may be edited manually by dragging the end to any desired point 
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on the slab.  In most cases, however, load separators will not have to be 

moved.   

 

FIGURE 6.2-3 SUPPORT LINE IDEALIZATION 

 DISPLAY OPTIONS 

Load projection. Displays the manner in which an applied load over the 

tributary of a design strip is represented on the support line. Loads that are 

located on a design strip, but do not fall on its support line are brought to 

the support line prior to analysis using ADAPT-RC or ADAPT-PT.  

Idealized tributary. Displays the idealized tributaries of the support line. 

Rotate fill pattern. Changes the orientation of a tributary’s hatching to 

avoid conflict with adjacent hatching. This tool is used when you generate 

a printed report of your modeling. If in print preview, adjacent design 

strips happen to have the same fill pattern, you may change the pattern 

using this option. 

The following icons can be used only after you have used the Generated 

Strips tool of the PT/RC Export ribbon or Generate Sections New tool of 

the Floor Design ribbon. They are not used to create a support line but are 

an essential part of the data transferring process in the ADAPT-PT or 

ADAPT-RC programs.  The buttons will not be visible until the design 

strips have been created. 

 Viewing the Design Strip. This button is used to create a 3-D 

rendering of the idealized design strip. The idealization is done for 

the purpose of exporting the design strip for analysis and design to 

either ADAPT-PT or ADAPT-PC. You can rotate and view the 

idealized model in detail and modify its geometry or loading 

before exporting it to ADAPT-PT or ADAPT-RC.  
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Each of the buttons displayed on the right margin of the viewing 

screen will open a text file that reports a specific aspect of the 

idealized model. These include information on span geometry, 

supports and loading. Click on each to view the contents. Some of 

the values of the report are linked to the displayed model. If you 

change the text value in the report, that change will be reflected in 

the display of your model. 

 Export to Strip Modeling. This button is used to write the 

support line input data to a subdirectory, ready to be 

analyzed with ADAPT-PT or ADAPT-RC.  This tool 

writes the input data only; it does not open either program.  

The subdirectory to which the data is exported is given the 

same name as the model file. 

 BuilderSum. This button opens a summary report of the 

designed design strip. The summary report includes strip 

results including bending moment, shear, stresses, and 

reinforcement diagrams. The user must design the sections 

within ADAPT-Builder for this option to initiate.  

 Display Support Line Elevation. This button will generate a 

cut along the length of the support line and display it at an 

insertion point of your choice. You can enlarge the 

thickness of the slab, by increasing the Z-scale from the 

Home ribbon Scaling panel. 

 Display Design Section Elevation. This button will generate 

a elevation cut for each design section along the support 

line and display it at an insertion point of your choice.  

 Support Line Wizard. This tool creates a support line automatically for 

export to ADAPT-PTRC. The Dynamic Editor is used to create a support 

line automatically for use with ADAPT-Builder. The use of the Dynamic 

Editor is described in the ADAPT-Builder 2019 New Features 

Supplement manual. Clicking on the Support Line Wizard tool opens the 

dialog box shown in Fig. 6.2-4. The support line wizard automatically 

generates a support line in the direction that you specify. The wizard 

searches for possible supports over a strip specified by the band width you 

define. The wizard detects slab edges, column ends, wall ends and wall 

center lines that are located within the band you define. Once it creates a 

support line and displays it on the screen, you will be able to edit it, if 
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needed. In most cases, it is simpler to use the wizard and edit its support 

line automatically than to create one manually.  

To generate a support line with the wizard: 

Click on the Support Line Wizard button on the Strip Modeling 

panel of the PT/RC Export ribbon. 

 

Select the span direction in the dialog box shown in figure. Then 

select the scanning area in which supports may be regarded in 

creation of the support line. 

 

The program will automatically catch every support in this selected 

area. 

 

Click on the OK button to create the support line. 

 

FIGURE 6.2-4 SUPPORT LINE WIZARD DIALOG WINDOW 

  Splitter. These tools create a new splitter.  Splitters are used to delineate 

the width of a design strip. They are now used solely to identify the width 

of a design strip tributary area in a location. Each splitter is associated 

with the design intended for one of the orthogonal directions, referred to 

as X- or Y-directions. It is defined according to the strip direction the 

splitter is meant to affect.  Each splitter affects strips in one specified 

direction at a time.  Therefore, separate splitters should be drawn for each 
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direction. For example, if a splitter is intended to affect the strips in the X-

direction, draw the splitter in the X-direction. 

To generate a splitter: 

Click on either the Create X-Direction Splitter or Y-Direction 

Splitter tool depending on the direction of the support line the 

splitter will be associated with. 

 

Set up the Snapping tools so the cursor will snap to the desired 

points (nearest point for slab edges, end point for column ends 

etc.).   

 

Draw the splitter.  Left-click the mouse at each point required. 

 

After the last point has been inserted, Press C to close the input of 

the splitter, or press the End key. 

 

To edit an existing splitter: 

Select the desired splitter.  

 

To open the dialog box just double-click on the splitter outline or 

right-click and select Properties from the menu that opens.  

 

Edit the input fields on each tab of the dialog box as required.  

 

Click OK to accept the new input values. 

 

 Strip Method Load Transfer (Specific to ADAPT-PT and ADAPT-RC). 

When a support line is designed to rest on another support line in the 

orthogonal direction and transfer its load to the supporting line, there is no 

physical support such as a column or wall at the intersection. The 

reinforcement in the slab or post-tensioning is designed to carry the load 

of the support recipient support line. In modeling for strip method, you 

must mark the location, where a support line is shedding load without the 

presence of a supporting wall or column.  

 Connect Drop Caps to Columns. This tool can be found in 

Model→Preprocessing panel. This tool is used to connect all existing drop 

cap endpoint with the endpoint of the column. The center point of the drop 

cap is moved to the center point of the column.  The connection of column 
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and cap makes sure that the complete cross-sectional area is considered at 

the support.  The resulting offset is automatically calculated. 

The following tools improve the quality and accuracy of modeling. For a support 

line to fully account for the existence of a column or wall support, when it comes 

to code check or export to ADAPT-PT, it should snap to the column or wall at the 

time of its creation. Once a support line is snapped to a column, it would 

automatically detect the properties of the column and report to you the moment 

and stresses at the face of the column. It also will give you the reinforcement at 

the face of column, as well as along other locations within the span. The support 

line wizard will automatically detect supports and snap to them. If you generate 

the support lines manually, however, or move a support after you created a 

support line, the snapping feature may be breached.  Two of the tools given below 

are intended to correct this situation. 

 Connect Support Lines to Columns and Walls. Use this tool to connect 

the existing support lines to walls and columns.  Support lines have to be 

connected to the endpoint of a column or both endpoints of a wall/beam to 

account for them fully in the design stage of your work.  

 Connect Beams to Columns and Walls. This tool can be found in the 

Model→Preprocessing panel. This tool establishes the snapping 

connection between all existing beams and adjacent walls or columns, 

where beam ends are adjacent to a support but are not snapped to it.  

While the program can handle a beam that terminates short of a column, 

for proper treatment of beams that are connected to columns you should 

use the Snap option. This tool will search for such instances in your model 

and will establish the connection.   

 Extend Support Lines to Slab Boundaries. This tool extends all existing 

support lines to the edges of the slab.  Use this tool if you created a 

support line manually, as it is likely you missed snapping its ends to the 

slab edges. If the distance of the support line end to a slab edge is more 

than the program’s tolerance, you must do the connection manually. 

 Align Structural Components. This tool can be found in 

Model→Preprocessing panel. This tool improves the quality of your 

modeling. You can automatically adjust the location of a wall or column 

that you have drawn to line up with the face of slab. Left click on the tool 

and follow the instructions at the bottom of the screen. Fig. 6.2-5 

illustrates the function of the tool in shifting the position of a wall and a 

corner column to the slab edges. The tool shifts the position of the wall 

and column but retains the edges of slab at their original position. 
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(a) Wall and Column Centered on Slab Edge 

 

(b) Wall and Column Aligned with Slab Edge 

 
FIGURE 6.2-5 REPOSITIONING OF BEAM AND COLUMN TO SLAB EDGE 

6.3 STRIP GENERATION TOOLS  

              

                Floor Design Ribbon                            PT/RC Export Ribbon 

 Generate Sections (Floor Design) & Generate Strips (PT/RC Export). 

This button is used to create the design strips automatically. It concludes 

by generating as many design strips as there were support lines created by 

you, taking into account the splitters that you may have used, in order to 

impose your preferences on strip width.  The design strip calculation can 

be followed up by requesting that the data generated be sent to ADAPT-

PT or ADAPT-RC by clicking on the Execute ADAPT-PTRC icon of the 

Export panel of the PT/RC Export ribbon 

 Delete Design Strips. This tool erases the data of the last automatically 

generated design strip calculations, but retains all the information that you 

entered manually, such as support lines and splitters.  This tool is 

generally used when you decide to modify design strips calculated by the 

program.   
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6.4 STRIP VISIBILITY TOOLS 

 

   

The above tools control the display of support lines, splitters, tributary regions, 

and design sections. Please refer to the description of each individual tool in 

section 4.13.7 of this manual. 

6.5 OTHER DATA SPECIFIC TO ADAPT-PT AND ADAPT-RC 

In addition to the general modeling data and tools described earlier, there are 

additional data that you provide for export of data to ADAPT-PT and ADAPT-

RC. These are grouped into data specific to the design strip you are currently 

dealing with, and more general data, such as allowable stresses, that apply to an 

entire project. 

6.5.1 Data Specific to Current Design Strip 

Support Boundary Conditions. Prior to exporting a design strip to 

ADAPT-PT or ADAPT-RC, you specify the boundary conditions of each 

of its supports. Fig. 6.5-1 shows the dialog window for specification of 

column supports. Open the property box of a column to access the tab for 

its boundary conditions. A similar dialog window is available in the 

property box of walls. 
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FIGURE 6.5-1 DIALOG WINDOW FOR SPECIFYING THE BOUNDARY  

CONDITIONS OF COLUMNS FOR ADAPT-RC/PT DATA 

6.5.2 Data Applicable to the Entire Project  

Enter the data that is applicable to your entire project in the dialog 

windows listed in this section, knowing that in each instance, you have the 

option to go and edit them individually in ADAPT-PT and ADAPT-RC.  

The dialog windows and data fields used in the following are essentially 

the same as those you have come to know in ADAPT-PT and ADAPT-

RC. A detailed explanation of each is provided in the respective manuals. 

In the following they are presented with a brief description. 

Concrete Material. Access this dialog window from the PT/RC 

Export→Material Properties→Concrete tool. 
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FIGURE 6.5-2 MATERIALS DIALOG WINDOW FOR ADAPT-RC/PT 

The following dialog windows (Fig.6.5-3) are accessed from the PT/RC 

Export→Design Criteria panel. 

 

(a) Effective Width Input Window 
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(b) Handling of Load Input Window 

 

 

(c) Tabs Each Covering a Section of Input Data 

 

(d) Tendon Shape Library 

 
FIGURE 6.5-3 INPUT DATA WINDOWS SPECIFIC TO ADAPT-RC/PT 
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7.1 OVERVIEW 

In this chapter you will learn how to obtain a finite element solution for your 

structural model. The building code check and determination of reinforcement is 

covered in a separate manual1. We start by assuming that you have created your 

structural model using the information in previous chapters. You have viewed 

your model in three dimensions (solid form) and are satisfied that it is correct. 

This chapter introduces the tools and steps that conclude with a finite element 

solution of the structure. The introduction of post-tensioning is covered in the 

ADAPT-Floor Pro manual. 

To obtain a finite element solution you: 

• Mesh the structure 

• Select the load combination 

• Solve the structure 

• View the solution 

• Examine the validity of the solution 

• Edit/apply boundary conditions 

Items related to building codes and calculation of reinforcement are handled in the 

ADAPT-Floor Pro manual and other manuals. 

In the normal course of analysis and design, you would specify the boundary 

conditions of your structure prior to its analysis. The proven procedure 

recommended here, however, is that you first obtain a FEM using the defaults of 

the program to validate your structural model. Then customize your boundary 

conditions and releases.  The program automatically applies a set of boundary 

conditions for the structure you have created, and automatically stabilizes it 

during the solution. 

In Single-Level mode, the program assumes that the floor you are dealing with is a 

typical story of a multilevel structure. It is resting on a similar floor below and 

supports a similar floor above. The far ends of the walls and columns of your 

structural model are assumed to be fixed against rotation, but free to slide in the 

horizontal direction. Also, the far ends of the lower supports are assumed to have 

been placed on firm (non-sinking) supports. The columns and walls themselves, 

however, will shorten based on the load they receive and their material properties. 

 
1 ADAPT-Floor Pro User Manual 
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The program places adequate supports at selected points to stop your structure 

from floating in the horizontal direction. The fixity provided by the program 

against floating horizontally would not impact your solution. Note: If you have 

separate slabs that are not connected to each other in the same level of a model, in 

single-level mode, the program will only automatically support one slab in the 

horizontal direction. The user would have to manually add stabilizing point 

supports to the other slab(s) in order for all slabs to be stable in the horizontal 

direction.  

The program offers a number of other features, such as including or disregarding 

one or more structural components in your analysis. It is good to review these 

features and take advantage of them after you have obtained your first finite 

element solution of your structural model. The descriptions of these features are 

included in the ADAPT-Floor Pro 2019 Basic Manual. 

7.2 MESHING 

7.2.1 Overview 

The meshing stage of your analysis consists of subdividing the slab 

regions into well-proportioned, quadrilateral finite elements. Using the 

mesh of the slab regions, the program automatically generates the finite 

elements of the beams, walls and columns.2 Hence, only slab regions need 

be meshed by you.  

You have two options for meshing – manual and automatic. It is 

recommended that you use the automatic meshing option of the program 

and edit the mesh generated. In general, you do not need to edit the mesh 

generated by the program.  In its automatic meshing option, the program 

uses an adaptive meshing capability that generates well-proportioned 

quadrilateral finite elements.  

7.2.2 Maximum Mesh Size 

In most cases, six to eight divisions for the typical span of a floor system 

gives design values (moments, shears) that are within 2 percent of the 

 
2  For the slab regions, walls and drop caps/panels, the program uses a flat shell element with both 

membrane and flexural degrees of freedom. For the beam and columns, the program uses a stick element 

with six degrees of freedom at each node. The subdivision of the columns and walls in the horizontal 

direction is controlled by a parameter that is in the initialization file of the program. Generally, two 

divisions are used. Vertically, the program automatically matches the division to that of the slab regions. 

Full connectivity between the walls, beams, columns and adjacent slab regions is automatically achieved by 

the program.  
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value obtained, if a very fine mesh is used.3 This accuracy applies to 

design stresses too.  In your first attempt, start with a suggested cell size of 

three feet (1.00 meters).  Most structural models can be analyzed and 

designed well with 3,000 to 4,000 cells. A complex structure may require 

up to 6,000 cells. It is very rare that you need to solve a single-level 

structure needing more than 10,000 cells. If you do, chances are that the 

structural modeling is not efficient. 

7.2.3 Meshing Tools 

The tools provided for meshing can be reached from the Analysis ribbon in 

the Meshing panel. They are:  

General Tools: 

Mesh Generation (Automatic) 

Manual Mesh Generation 

Erase Mesh 

Advanced Tools: 

Node Proximity Detection 

Shift Node Automatically 

Shift Node Manually 

Cancel Node Shift 

Exclude Meshing 

Display/Hide Component Representatives. 

 

In this manual we will be dealing with the general tools, including Node 

Proximity Detection from the advanced tools. Once you become more 

familiar with the operation of the software, you may wish to explore the 

advanced tools.4 

Automatic Mesh Generation. Click on the Mesh Generation  tool 

from the Floor Design→Meshing panel, the following dialog window 

opens. 

 
3. The Technical Note TN-184: “Mesh Density and Accuracy of Design Values Using ADAPT-Floor Pro” 

gives a detailed evaluation of the mesh density and the accuracy of the solution. This Technical Note can be 

downloaded from the ADAPT website, www.adaptsoft.com. 
4 The Advanced Tools of Meshing are described in the ADAPT-Floor Pro user manual. 
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FIGURE 7.2-1 AUTOMATIC MESHING DIALOG WINDOW 

 

Select three feet (1.0 meters) for Suggested Cell Size. 

 

For Node Consolidation select a value between 1.5 to 2.0 times the 

average slab thickness. Again, this feature is discussed in detail in 

ADAPT-Floor Pro User Manual. 

The program will scan your structural model in order to determine 

whether the details of structure are such that a cell size will be less than 

the size suggested by you. If such a location is detected, the program will 

encircle and display it on the screen (Fig. 7.2-2).  In most instances, it is 

best to ask the program to continue.  Should it be impractical to mesh the 

structure with the mesh size you have specified, the program will let you 

know and request that you select a smaller mesh size. Follow the 

instructions on the screen. 

 

FIGURE 7.2-2 CIRCLE IDENTIFIES WHERE DISTANCE IS LESS 

 THAN USER DEFINED SIZE 
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Figure 7.2-3 shows an example of a structural model ready for mesh. 

Once successful, the program will display the mesh, as is shown in Fig. 

7.2-4. 

Manual Mesh Generation. You can generate the meshing of your 

structural plan manually. You can also use the manual meshing option of 

the program to edit automatically generated mesh. The process of manual 

meshing is illustrated through the following example (Fig. 7.2-5). 

 

FIGURE 7.2-3 STRUCTURAL MODEL, READY FOR MESHING 

 

FIGURE 7.2-4 AUTOMATIC ADAPTIVE MESHING OF 

THE STRUCTURAL MODEL 
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(a) 3D View of Structural Model 

Click on the Manual Mesh Generation  tool, to get the dialog box 

shown in (b).  

 

(b) This dialog box opens, when you click on Manual Mesh Generation. 

Select the number of divisions in each direction. 

 

(c) Once the Manual Meshing tool is activated, the program converts your model to its 

component representation, consisting of lines and points. The nodes of your manual mesh 

should coincide with the points and lines shown on plan. 
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(d) Click on the four corners of the region you wish to mesh. The program maps a mesh 

over the region. 

 

(e) Pick each node as shown above, making sure that it includes all the cells common to 

that node (generally four) and pull it to snap to the center of a column (point) as shown in 

(f) or the centerline of a beam (line). 

 

(f) Common node of four cells is pulled and snapped to the center of column. 

 

(g) Completed model in which the cells nodes are pulled to coincide with the component 

representatives of columns and the beam. 

 
FIGURE 7.2-5 ILLUSTRATION OF MANUAL MESHING PROCESS 

Figure 7.2-6(a) show a structural model that is meshed manually (Fig. 

7.2-6(b)) 
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(a) Structural Model 

 

(b) Display of Manually Generated Mesh 

FIGURE 7.2-6 MANUAL MESH GENERATION OF  

A STRUCTURAL MODEL 

 

Clear Mesh.  This tool will erase the mesh, whether generated 

automatically or manually. 
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7.3 EXECUTE ANALYSIS 

Execute Analysis.  Click on this button in the Analysis panel of the Analysis 

ribbon to start the analysis. The program goes through several steps and concludes 

with the analysis results. If you did not enter any loads prior to the analysis, the 

results will be for the selfweight of the structure under the Service load 

combinations.  The program will prompt you on the screen to resolve any errors. 

Analysis Options.  Located within the Analysis panel of the Analysis ribbon. 

This tool opens the analysis options dialog window (shown below). 

 

FIGURE 7.2-7 ANALYSIS OPTIONS 

 DIALOG WINDOW 

In your fist finite element run, you need not disable the Stabilize slab 

automatically against in-plane translation and rotation option. If your input 

loading is limited to the vertical direction, and you do not provide fixity against 

horizontal body movement of the entire structure, the structural model is free to 

float (roll) in the horizontal plane. The program will automatically stabilize the 

structure. When there are horizontal loads and you have provided restrains against 

horizontal movement, however, you will need to disable the program’s automatic 

stabilization feature by unchecking the box. 
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7.4 VIEW ANALYSIS RESULTS 

The program has two locations where one can view Analysis Results. The user 

can view results through the View Analysis Results tool (legacy results viewer) or 

using the Results Browser that opens upon the completion of the Analysis. 

  View Analysis Results Tool. Click on this tool to open the three-

dimensional viewer of the program and examine the solution obtained. 

Once the 3D viewer opens, do the following: 

• On the left margin of the screen, click on the Load 

Cases/Combinations button. 

• From the list that opens, select Service (Total Load). 

• Click on the Results button on the top of the screen. 

• From the list that opens, select Z-Translation. 

• Finally, click on the Display Results tool.  

This will display the deflected shape contour of your structure. If the 

deflected contour does not display, click on this button:   

• Use the Warp Display  and Rotate  tools to examine the 

deformation of the structure. Make sure the slab does not displace 

excessively where it is supported on walls and columns. 

• Use the other tools on the screen for closer examination of the 

solution. 

Results Browser. The results browser opens on the left side of the 

ADAPT-Builder User Interface upon the completion of Analysis. Once the 

results browser opens, do the following: 

• In the Loads tab of the Results Browser, check the box next to 

Load Combos→Service→Service (Total Load). 

• Click on the Analysis tab of the Results Browser, check the box 

next to Slab→Deformation→Z-Translation. 

This will display the deflection contour of your structure. If your deflected 

contour does not display, click on the blue check mark at the upper left of 

the Results Browser. 
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• Use the Zoom and Rotate  tools to examine the deformation of 

the structure. Make sure the slab does not displace excessively 

where it is supported on walls and columns. 

• Go to the Settings tab of the Results Browser to change the display 

of results for closer examination of the solution. 

7.5 EXAMINE DESIGN VALUES 

Close the 3D viewer and return to the main screen. You can examine the design 

values by generating manual cuts at locations of your choice. The program has the 

option of automatically obtaining the design values for the entire floor system and 

performing a code compliance check. This option is explained in the ADAPT-

Floor Pro user manual. In this section, we limit ourselves to the manual 

examination of selected locations. 

Consider the structural model shown in Fig. 7.5-1. We already have obtained a 

solution for this structure, viewed it in three dimensions and are satisfied with the 

outcome.  

Next, let us examine the design values, stresses and the reinforcement required at 

a given location in the slab. From Floor Design→Section Design panel, click on 

Create Manual Design Section  icon. Follow the instructions in the Message 

Bar of the screen and draw a line over the plan to identify the cut (location) for 

which you seek the values. Figure 7.5-2 displays an enlargement of the interior of 

the floor plan with two manual cuts. 

• From the Floor Design→Section Design panel, click on the Design the 

Design Sections  icon.  

• Once the operation is complete, double-click on the cut to open up its 

property box (Fig. 7.5-3).  This table lists the results of the forces acting 

on the cut, reduced to six actions (three forces and three moments) and 

expressed at the centroid of the cut, reinforcement required, and the 

deflection ratio (N/A to strength combinations for the load combination 

selected at the top of the Actions section. The sections moment capacity 

and demand are given in the window as well. 

• Additionally, the user can view the results for a manual design section cut 

graphically through the Results Browser. In the Analysis tab expand the 

Manual Design Section tree. Select an Action or Code Check item you 

want to review the results for. The program will then show the result 

graphically on plan along the manual design section cut. 
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FIGURE 7.5-1 PLAN OF THE STRUCTURAL MODEL 

In addition to the window of design values, the program shows the envelope of 

reinforcement area on plan in the direction, where the reinforcement should be 

placed (Fig. 7.5-4). 

 

FIGURE 7.5-2 MANUALLY GENERATED CUTS ON PLAN  
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FIGURE 7.5-3 WINDOW OF DESIGN VALUES FOR 

 MANUAL CUT 

 

FIGURE 7.5-4 DISPLAY OF REBAR ON PLAN  
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7.6 Edit/Apply Boundary Conditions 

7.6.1 Overview 

As explained earlier, the program uses default support conditions and 

stabilizes your structural model automatically to obtain a solution. There 

will be situations, however, when you may want to specify support 

conditions other than the program defaults. This section guides you 

through the process of editing or applying boundary conditions. 

The boundary condition describes the way your structural model is 

attached to its supports. All the components of your structural model are 

assumed to be rigidly connected to one another where they meet. For 

example, a column shown below a slab is assumed by the program to be 

rigidly connected to the slab. You may wish, however, to have a hinge 

connection to eliminate transfer of moment from the slab to the column. 

The specification of a condition other than full fixity among the structural 

components of your model is called a release.  For example, you can 

release a slab to slide over a wall. The specification for releases can be 

directly accessed from the property box of each structural component.  

The following is a quote from an earlier section of this manual and 

describes the default boundary conditions of the program. 

In Single-Level mode, the program assumes that the floor you are 

dealing with is a typical story of a multilevel structure. It is resting 

on a similar floor below and supports a similar floor above. The 

far ends of the walls and columns of your structural model are 

assumed to be fixed against rotation, but free to slide in the 

horizontal direction. Also, the far ends of the lower supports are 

assumed to have been placed on firm (non-sinking) supports. The 

columns and walls themselves will shorten based on the load they 

receive and their material properties. The program places 

adequate supports at selected points to stop your structure to float 

in the horizontal direction. The fixity provided by the program 

against floating of the structure in the horizontal direction would 

not impact your solution. 

7.6.2 How to View and Edit the Boundary Conditions 

The program’s default boundary conditions consist of point supports 

below the columns and line supports below the walls. There might be 
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other support conditions in your model that you may have imposed, such 

as a line spring, or a point support below a slab.  

From the Select/Set View Items ( ) go to the FEM tab and select the 

following check boxes: 

Point Support 

Line Support 

Click OK to close the dialog window. The icon of the boundary conditions 

should appear on the screen. For better viewing, click on the Top-Front-

Right View button ( ) or a similar one, in order to display a perspective 

view of the structure. If the symbol sizes of the boundary conditions 

displayed are not large enough for easy viewing and selection, go back to 

the Select/Set View Items window and change the symbol size of the point 

and line supports to a larger value. 

Select the boundary condition symbol you want to view or edit. 

Depending on which type of boundary symbol you select, a dialog 

window such as the one shown below will open.   

 

FIGURE 7.6-1 POINT SUPPORT DIALOG WINDOW 

Among other information, the dialog window displays the restraints of the 

support in or about various directions. Edit as required. Click to tick mark 

button ( ) to accept your modification and close the window. 

7.6.3 How to Apply Boundary Conditions 

To specify a support condition at a point, or along a line in your structural 

model, use the tools in the Model ribbon Supports and Springs Panels. 
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7.6.4 Model Ribbon, Supports and Springs Panels 

  

 Add Point Support. This tool is used to specify a point anywhere 

on your structural model where you want to set the displacements 

(translation or rotation) in or about any of the three axes to zero. 

You can use this tool to specify fixity at a point in a slab region, or 

at the bottom or top of a column. To insert a point support: 

• Click on the Add Point Support icon. 

• Insert the point support by snapping it to the 

location/structural component. For example, for a column 

snap to column’s center. The point support will be inserted 

at the active plane.6  

• If the point support was not inserted in the location you 

intended, edit the location by going through the view/edit 

steps described above. For example, if you want the point 

support to be at the bottom of a column, open the property 

box of the point support. From the General tab, select 

Bottom Plane for the location (Fig. 7.6-2). 

 

FIGURE 7.6-2 POINT SUPPORT 

DIALOG WINDOW 

 
6 The active plane is the default for insertion of the supports. You have the option of defining the 

particulars of a support, such as its point of insertion and its fixity beforehand, then inserting similar 

supports at locations of your choice. Go to Home→Settings→General Settings and check the “Open Item’s 

Property Box Automatically” option. 

 



 FINITE ELEMENTS MODELING TOOLS  Chapter 7 

199 

 Add Line Support. Many of the comments made for specification 

of point supports apply equally to line supports. Line supports can 

be placed below slabs, walls or beams. To insert or edit the 

specifics of a line support, follow the same type of instructions as 

described for point supports. 

 Add Point Spring. This tool is used to specify the point spring at a 

location on a slab. The insertion and view/editing are similar to a 

point support.  

 Add Line Spring. This tool is used to specify the lines in which 

the slab is supported on springs. 

 Add Area Spring. To insert an area spring below a slab: 

• Click on the Add Area Spring icon. 

• Follow the instruction on the screen to draw the region 

where area spring applies. If any part of the region you 

draw is not covered by a slab, the program will 

disregard that part. 
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A1 Treatment of Compound (Interconnected) Wall Assemblies 

Walls are not always isolated, simple, and rectangular in shape. In many cases 

walls are assemblies of two or more wall segments, such as (a) in Fig. A1.1-1. 

Both ADAPT-Modeler and Floor Pro can faithfully model, and account for the 

structural features of an entire wall assembly.  

A1.1 Structural Modeling 

In your structural model, a wall assembly must be broken down into rectangular 

wall segments. There are two options as illustrated in Fig. A1.1-1. In option 1, 

each wall segment butts against the side of an adjoining wall, with no overlap of 

wall segments. In option 2, the wall segments are connected to one another at 

their centerlines. In both modeling options, the program treats the segments 

working together as one whole. Option 2 takes less computer resources for 

analysis and design and is the recommended modeling method. If you follow the 

modeling procedure outlined in this manual, the structural drawing you will 

generate from either of the two options will show the wall in its true form (Fig. 

A1.1-1(a)).  

 

(a) Actual wall assembly 

 

(b) Modeling option 1 

 

(c) Modeling option 2 

FIGURE A.1.1-1 MODELING OPTIONS OF WALL ASSEMBLIES 

A1.2 Support Lines and Design Strips 

As much as practical, you will use the Support Line Wizard ( ) for export to 

ADAPT-PTRC or the Dynamic Editor ( ) for design within ADAPT-Floor 

Pro, to generate support lines. For compound wall assemblies, it would not be 

practical to consider each wall segment as a separate support. Ideally, you would 

like to identify a point that is the beginning of wall support, and another one at the 
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end of the wall support. Again, there are two options for you to achieve this, when 

you use the Support Line Wizard or the Dynamic Editor. 

Option 1 

In this option, you can change the property of a wall segment, such as wall 

segment marked “3" in Fig. A1.2-1(b) to “disregard.” You do so, by opening the 

property window of the wall marked “3,” and under the FEM tab change its 

property from “consider” to “disregard.” This change in property will result in the 

wall segment not to be accounted for when the support line wizard or dynamic 

editor automatically creates a support line. The outcome will be like Fig. A1.2-

1(e). If the wall segment 3 is not disregarded, the support line created 

automatically will be as shown in Fig. A1.2-1(d).  

Option 2 

In this option you do not “disregard” a wall segment. After the support line is 

generated, you will eliminate the support line segments that zigzag over the 

interconnected wall segments. Do the following. 

• Turn the support line symbol on. The small circles are the “support” 

locations of the support line.  

• Retain the first and the last support points and delete the support points 

(circles) in between. Do so by using the Remove Point tool ( ).  The 

outcome will be a view, like Fig. A1.2-2. 

 

 
 

(a) Original wall 

 
(b) Wall subdivided for 

structural modeling 

 
(c) Wall centerline and 

ends 

 

 
(d) Support line created 

automatically considering 

 both walls 

 

 
(e) Support line created 

automatically, considering 

wall 2 only 

 

 
(f) Display of support line” 

support points” 

FIGURE A1.2-1 TREATMENT OF SUPPORT LINES FOR COMPOUND WALL 

SEGMENTS 
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FIGURE A1.2-2 SUPPORT LINE WITH TWO SUPPORT 

POINTS OVER COMPOUND WALL 

If you disregard a wall segment prior to the analysis, its stiffness will not be 

included in the analysis of the floor system. But, at design time, its presence will 

be recognized. Walls segments that are primarily for architectural reasons and do 

not provide a significant support to the structure are best disregarded in the 

analysis. Otherwise, in creation of support lines use Option 2, whereby you would 

edit the automatically generated support lines. 
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